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Preface

This manual explains how to install, configure, and use WinSPIRS v4.0
for Windows NT®, Windows 98%, Windows 95®, Windows 3.11®.

Using this Manual

This Manual is available in PDF format so you can view it in Adobe
Acrobat Reader. You can print the document, or use it online. If you use
it online you can click on a Table of Contents entry, or a cross-reference,
to move to the relevant text.

Some Conventions used in this Manual

These are the conventions used throughout this manual

Example

Describes

Isproot/bin

pkgadd

filename

filename

This bold type indicates a filename, or a directory
path, or a URL.

This typeface indicates text as you would type it, or
an example of how it appears on the screen.

This bold type indicates a placeholder, when in-
cluded in something you type. You substitute the
text appropriate to your system.

This italic type indicates a placeholder, when de-
scribed in the text.

(Sheet 1 of 2)
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Example

Describes

root

File

[Enter]

This italic type indicates an account name.

This bold type indicates a menu, menu option, or
the name of a button on the screen.

It is also used for command names.

This bold type inside [ and ] indicates a key on your
keyboard. Note: if the instructions say “Enter...”
this means type in the text as instructed, (substitut-
ing your text for any placeholders) and press the
[Enter] key.

(Sheet 2 of 2)




Chapter 1

Before You Begin

What is in this
Manual?

1-1

Introduction

SilverPlatter databases are organized collections of records. Each record
represents an article, book, bibliographic citation, etc. Records are
divided into categories of information known as “fields,” such as title,
author, etc.

WinSPIRS, the SilverPlatter Information Retrieval System for Windows,
lets you search SilverPlatter databases and display, print, or save the
retrieved records. You can also save your search strategy to use again in
later sessions.

Before you begin working with WinSPIRS, you should be familiar with
general Windows techniques, such as how to move and resize windows
and how to use the mouse. If you have any Windows-related questions,
see your Windows documentation. All references to mouse clicks refer
to the left mouse button on a right-hand mouse unless otherwise
specified.

Listed below are brief descriptions of the contents of this manual.

Read... If you are... It will tell you...

Chapter 2 Responsible for How to get the
installing WinSPIRS software, and install
and configure it.

Chapter 3 A WInSPIRS user How to use the
different WinSPIRS
screens

(Sheet 1 of 2)
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Introduction

Read...

If you are...

It will tell you...

Chapter 4

Chapter 5

Chapter 6

A WIinSPIRS user

A WinSPIRS user

A WinSPIRS user

How to search using
WinSPIRS

How to use the records
you find: marking,
sorting, printing, and
downloading records,
and changing various
options.

An alphabetical list of
menu items and
buttons.

(Sheet 2 of 2)
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Contacting SilverPlatter

By Email

By Telephone

To learn more about SilverPlatter software, or if you have any queries
about installing and running the WebSPIRS software, please contact us
in one of the following ways:

support@silverplatter.com

Call your SilverPlatter distributor, or one of the following SilverPlatter
Technical Support teams:

For the Americas, Japan, Australia, and the Pacific:
Boston Office:

Tel: 1-781-769-2599
1-800-343-0064 (US/Canada)

Fax 1-781-769-8763
For Europe, Africa, Middle East, and South Asia:
London Office:

Tel: +44 (0)181-585-6400
0800-262-096 (UK)

Fax: +44 (0)181-585-6640

Amsterdam Office:

Tel: +31 (0) 20 6259650
Fax: +31 (0) 20 6237408
Berlin Office:

Tel: +49 30-85 77 99-0
Fax: +49 30-85 77 99-99
For Asia:

Hong Kong Office
Tel: 852 2529 0356
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Fax: 852 2804 2746

SilverPlatter Web Site ~ www.silverplatter.com
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Chapter 2 |nSta”|ng WIﬂSPlRS

This chapter provides details on installing WinSPIRS including:

If you have an earlier version of WinSPIRS
Checking hardware and software requirements

Installing WinSPIRS from SilverPlatter’s FTP site, Software
Resource CD, or installation disks

Network installation instructions
Configuring WinSPIRS

Accessing databases on network directories
Setting up SilverLinker

Setting up SDIs and Alerts

Providing Library Holdings Information

If You Have an Earlier Version of WinSPIRS

You can install WinSPIRS 4.0 over an existing version of WinSPIRS if
it is version 2.0 or later. If you do this, WinSPIRS 4.0 updates the
winspirs.ini file, but retains any options you have set.

If you have a version of WinSPIRS that is earlier than WinSPIRS 2.0, we
recommend that you install the software into a different directory.
WinSPIRS 4.0 will not update the winspirs.ini file correctly if installed
over versions earlier than WinSPIRS 2.0.
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Checking Hardware and Software Requirements

Before you start to install the software you must check the hardware
requirements for your platform.

For the very latest information about hardware requirements, please see

the SilverPlatter web site at:
http://www.silverplatter.com/erl/ericlientreq.htm

Getting the Software

The ERL software and full documentation set is available on
SilverPlatter’s ftp site.

Downloading with a 1. Access the SilverPlatter web site; http://www.silverplatter.com
Browser
2. Click on the link to the ftp site, and click on Software, then on
winspirs4.0

3. Double-click on each file to download it. The files are:
* win40.exe
*  The release notes (readme.txt)

*  The WinSPIRS User Manual (this manual - winman40.pdf)

Downloading from 1. Use anonymous ftp to connect to SilverPlatter’s site:
the ftp Site ftp.silverplatter.com

Login with user-id anonymous and enter your email address as a
password.

2. Change to the /software/winspirs4.0 directory.
(To do this, enter cd /software/winspirs4.0)
3. Make sure you will download the files as binary files.
(To do this, enter bin)

4. Download all the files from the directory.
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(To do this, enter mget *. You are prompted to enter y to agree to
download each file.)

The files will download into whatever is your local directory. The
files are:

*  win40.exe

*  The release notes (readme.txt)

*  The WinSPIRS User Manual (this manual - winman40.pdf)

Installing the Software

Installing a version
from the ftp site

Installing from the
Software Resource
CD

Installing from Disk

If you downloaded software via FTP, double-click on win40.exe to
expand the file and start the installation program. This is a self-extracting
file, which extracts to your \temp directory.

When you have completed the installation, you can use Reconfig.exe to
configure WinSPIRS

SilverPlatter regularly distributes its current ERL and SPIRS software on
the “SilverPlatter Software Resource CD.”

1.

If you have a copy of the Resource CD, follow the instructions that
come with the CD to access the WinSPIRS Setup program.:

When the WinSPIRS Setup screen appears, follow the instructions
on-screen. Setup presents a license agreement, which you must
accept to install WinSPIRS, and then asks whether you want to
install a standalone or shared version, what directory you want to
install in, and what folder you want to put the WinSPIRS icons in.

If you have WinSPIRS installation disks, follow the instructions below:

1.

2.

Insert WinSPIRS Setup Disk 1 into the computer’s drive.
Choose Run from the Taskbar’s Start menu in Windows 95, or from
the Program Manager’s File menu in Windows 3.1. Windows

displays the Run dialog box.

Click Browse, open the disk, and double-click on setup.exe.
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4. Click OK to run WinSPIRS Setup.

5. Follow the instructions on-screen. Setup presents a license
agreement, which you must accept to install WinSPIRS, and then
asks whether you want to install a standalone or shared version, what
directory you want to install in, and what folder you want to put the
WinSPIRS icons in.

Network Installation Instructions

First Stage: Installing
on the Server

The WinSPIRS Setup program lets you install WinSPIRS as a standalone
or shared application.

If you install WinSPIRS as a shared application on a server, for example,
you need to install some software on the server and some on the client
machines.

When you set up a network installation, you choose which of the
following types of installation you want:

*  Single (server) shared copy of configuration files

All users use the settings in the configuration files that are on the
server.

*  Multiple (local client) unique copies of configuration files

Client machines have their own configuration files. Users can make
their own settings, or you can make specific changes to the set up for
specific machines.

Note: For a single WinSPIRS installation on a server, all the clients must
have the same configuration type (All “shared” or all “unique”
configuration files.

In either case the installation is in two stages: installing software on the
server, and on the client.

1. Check that there are no winspirs.ini or erlcint.cfg files already in
the server’s Windows directory, or in the intended WinSPIRS
installation directory on the server.
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Installing on the Client
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Working on the server (not remotely from a client machine), run
setup.exe from the WinSPIRS installation files.

Choose the option for “Shared”, multiple-user installation type.

Uncheck the Configure WinSPIRS box on the final install wizard
screen, so that the Reconfig utility is not run automatically.

For single (server) copy of configuration files:

1.

During install, choose the option “shared”, single configuration for
all users.

The Reconfig and ERL configuration (erledit.exe) utilities can be
run on the server at any time, to change options for all users. After
running Reconfig, use a text editor to remove the directory path
from the ERLPATH statement near the end of the winspirs.ini file.
This line then only contains the following:

ERLPATH=

For multiple (local client) copies of configuration files:

1.

During install, choose the option “Unique” for one per user
configuration.

Delete the winspirs.ini file in the WinSPIRS installation directory
on the server.

Do not run Reconfig directly from the server at any time, or perform
aclient installation on the server itself. These actions would create a
copy of winspirs.ini in the server’s WinSPIRS installation directo-
ry, and this copy would override the locally-held configuration files
of the clients.

Note: If you want to run WinSPIRS from the server after multi-user
installation (rather than running WinSPIRS from one of the clients)
we recommend that you do an additional, entirely separate, standal-
one “workstation” installation on the server, selecting a different
WinSPIRS installation directory and icon group.

Working on each client machine (not remotely from the server), run
the setup.exe that is in the server’s WinSPIRS directory. This
version of setup differs from the one in the initial WinSPIRS
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installation files.
For a single copy of configuration files
If you opted for “shared”, single configuration, during server installation:

1. Running setup.exe creates a WinSPIRS icon, which allows your
user to run the server copy of WinSPIRS, using shared configuration
settings.

For multiple local copies of configuration files

If you opted for “unique”, one per user configuration, during server
installation:

1. Running setup.exe creates a WinSPIRS icon and a Reconfig icon.
These let the client machine run the server’s copy of WinSPIRS, and
Reconfig, but using configuration files on the local machine.Using
Reconfig from the client machine does not affect any other clients.

Note: If WinSPIRS is to be used as an ERL client, you must set the
ERLPATH. To do this, run Reconfig from the client, and select
ERL Options. Then enter the path to the directory containing the er-
IcInt.cfg file. This file specifies which ERL servers can be accessed:
typically a shared copy of erlcint.cfg is held on the server. If the
ERL servers to be accessed need to be set up for each individual cli-
ent, you can create a suitable erlcint.cfg using a temporary standal-
one installation of WinSPIRS. Then you can copy erlcint.cfg to the
client machine, and set up the ERLPATH appropriately.

Configuring WinSPIRS

WinSPIRS is installed with a number of default options that determine
various settings, such as how records are displayed, printed, and
downloaded. You can modify these options at any time after installation
with the WinSPIRS Reconfiguration program.

To run the WinSPIRS Reconfiguration program:

1. Double-click the Reconfig icon in the WinSPIRS folder to display
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the Configuration Options menu.

WinSPIRS [x]

Configuration Options

Record Display Options...

Search Options...

Frint Options...

File Options...

Workstation Options...

Library Holding Options...

ERL Options...

SDI/Alerts Options...

Rewvert to Default Settings:

| Save I | Cancel I | Help I

FIGURE 2-1 Configuration Options menu

The following list shows the options available

Option

Use

Record Display Options

Search Options

Print Options
File Options

Workstation Options

Library Holdings Options
ERL Options
SDI/Alerts Options

Revert to Default Settings

Change the display of records

Set Fast Phrase searching, and
display of intermediate results

Set print options
Set download options

Set general display and search
parameters for this workstation

Set up links to library holdings
Set up ERL server access
Set up SDI and Alerts access

Reset each configuration to its
default setting

Refer to the online Help for detailed
options and default settings.

information about the configuration
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2. Click the option you want to change, such as ERL Options...
3. Modify the options as desired.
4. Click OK to save the changes.

5. If necessary, click Revert to Default Settings to reset each
configuration option to its default setting. Note that this option
erases all ERL settings.

6. When you have finished, click the Save button.

Accessing Databases on Network Directories

To access databases on network subdirectories:

1. Open the file winspirs.ini in the WinSPIRS directory, using any text
editor.

2. Inthe [CORE] section of winspirs.ini make sure that MAGDRIVE=
is setto 1, and edit DRIVES= to specify the directories for the
databases you want to access. Enter the databases as a list separated
by semi-colons (; ). You can include UNC or drive-letter based
paths. You can use the wildcard * at the lowest level of a path to
include all the databases in that subdirectory.

For example: to allow access to all the databases in directories one
level under DBASES on the machine SERVER, you would enter:

[CORE]
DRIVES=\\SERVER\DBASES\ *
MAGDRIVE=1

3. Save winspirs.ini as unformatted text and close the file.

Setting up SilverLinker

WinSPIRS 4.0 includes support for the SilverLinker database, which
provides links from bibliographic records to the full text of articles in
electronic journals to which your library subscribes.
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The SilverLinker database contains URL links from articles. These links
are displayed dynamically within SilverLinker-enabled bibliographic
databases. The links appear as hotlinks in a separate field with the short
name FTXT and link directly to the website where the full text article is
located.

SilverLinker full-text links are displayed only when the SilverLinker
database, and your SilverPlatter bibliographic databases, are installed on
ERL dbserver 4.0. They are not available for databases accessed directly
by WinSPIRS. In addition, your institution must have subscriptions to
electronic journals at the web site or sites that host the full text.

For more information about SilverLinker see the ERL Administrator s
Manual available at the SilverPlatter ftp site, for example at:
ftp:/iftp.silverplatter.com/software/erl-server/solaris/

Note: Earlier versions of WinSPIRS do not support the SilverLinker
feature. In WinSPIRS 2.1 and 2.2, the full text links display as hotlinks,
but clicking the link displays an error message.

Note: Users must display WinSPIRS to display the FXTF field to see
SilverLinker links.

Setting up SDIs and Alerts

Links to WebSPIRS
for SDIs and Alerts

In libraries that have the WebSPIRS 4x gateway installed, you can link
WinSPIRS 4.0 to WebSPIRS so that authorized users can access the SDI
(Selective Dissemination of Information) current awareness search
feature.

The SDI feature lets users save and identify searches to be rerun
automatically. The user specifies the interval at which they want the
search to be rerun along with the email address to which search results
are to be returned.

With WebSPIRS 4.1 and later, the Alert feature is also available:
authorized users can subscribe to a selection of searches prepared by the
administrator or librarian. These searches are run periodically, and the
results emailed to the user.

Users must have the following components to take advantage of these
features:



2-10 Installing WinSPIRS

Configuring
WinSPIRS to Allow
SDIs and Alerts

* Anaccount on a WebSPIRS 4x server and an internet or intranet
connection and its URL, to access WebSPIRS 4x.

* A browser: Netscape 3.01 or Internet Explorer 4 or later.
*  Access to the databases required for the SDI.
*  Windows 95, 98 or NT.

*  Two logins assigned on the ERL Server, for when a user creates or
edits an SDI. This is because the ERL Server treats the contact
between WinSPIRS and WebSPIRS, which takes place through the
Server, as two simultaneous Server users: one a WinSPIRS user, and
one a WebSPIRS user. In some circumstances, these two users will
share the same username. For this reason, you should set the
Server’s limit on the number of simultaneous logins for a single
username to two or more.

Note: Because of buffer size restrictions, browsers currently available on
Windows3.x systems do not support WebSPIRS 4.x. For this reason,
WinSPIRS running on Windows 3.x cannot use SDIs and Alerts.

Note: The databases selected for a WinSPIRS search must be available
on the WebSPIRS server hosting the SDIs.

For information about configuring WebSPIRS for SDIs and Alerts, see

the WebSPIRS Implementor’s Guide, available at the SilverPlatter web
site at http://webspirs.silverplatter.com/ws40docs/

You give or restrict access to the SDI and Alerts feature using the
WinSPIRS 4.0 configuration option: SDI/Alerts options...

To setup the SDI and Alerts features:
1. Choose the Reconfig icon from the WinSPIRS folder.

2. Click SDI/Alerts Options... on the Configuration Options screen to
display the SDI/Alerts Options dialog box.

3. Click Allow SDI Creation and Access to enable users to create
SDIs, and Allow Access to Alert Service to enable users to
subscribe to alerts.

4. Enter the URL for WebSPIRS.
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Creating an SDI and
Subscribing to an
Alert
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5. To specify a username and password, click Login to WebSPIRS
automatically and enter a username and password.

Note: WinSPIRS stores only one username and password for an in-
dividual workstation. This is true if the software is installed individ-
ually, or by a network installation with configuration files on each
client PC. If the network installation has been done with shared con-
figuration files on the server, a// users share only one username and
password.

6. Click OK to close the SDI/Alerts Options dialog box.

7. Click Save to save your changes and exit the Configuration Options
screen.

WinSPIRS 4.0 contains new File menu items that function with the SDI
feature. The following menu items appear only after WinSPIRS has been
configured to enable the SDI feature.

Use this File Menu Item To do this

Create SDI... Set up an SDI. After conducting a
search and choosing this menu item,
WInSPIRS 4 links automatically to
WebSPIRS and displays the Create
SDI screen.

Show SDI Account... Edit or administer existing SDIs by
linking to WebSPIRS 4 to view an
account users setup previously.

Alert Service... View and subscribe to alerts by linking
to WebSPIRS 4.1.

For instructions on how your users create SDIs, see “Creating an SDI
from WinSPIRS” on page 4-32 and “Subscribing to an Alert” on page
4-33.
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Providing Library Holdings Information

About the Holdings
Conversion Utility
(HCU)

About SPLHA

Making Holdings
Information Available

The Holdings Conversion Utility (HCU) lets you display local holdings
information about SilverPlatter bibliographic databases.

HCU converts a library’s serials holdings file (in ASCII or MARC
format) into a SilverPlatter formatted file which, when installed on a
server or stand-alone system, can be used to display local holdings
information along with SilverPlatter bibliographic records. HCU-
generated files support the display of holdings information within any
ISSN-based SilverPlatter database. HCU can be installed on either a
Windows 32-bit platform or a UNIX platform.

WinSPIRS 4.0 supports library holdings for all databases supported by
the Holdings Conversion Utility (HCU).

If users have a browser running on a WinSPIRS 4.0 workstation,
WinSPIRS 4.0 also supports holdings messages with embedded URLs.
(Earlier versions of WinSPIRS do not support URLs embedded in
holdings messages.)

For details of how to create library holdings information, see the
Holdings documentation available at SilverPlatter’s ftp site, for example
at: ftp:/iftp.silverplatter.com/software/hcu/solaris/.

WinSPIRS 4.0 will continue to support files generated by the earlier
utility: SilverPlatter Library Holdings Administration (SPLHA)
However, WinSPIRS 4.0 does not support both formats simultaneously.
Your holdings must be in either the SPLHA format or converted to the
new holdings format.

For details of how to create library holdings information, see the HCU
documentation.

To make holdings information available:
1. Choose the Reconfig icon from the WinSPIRS menu.

2. Click Library Holdings Options... on the Configuration Options
screen to display the Library Holdings Options dialog box.

3. Check Holdings Exist, and specify the directory in which the
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holdings file is located.
Click OK to close the Library Holdings Options dialog box.

Click Save to save your changes and exit the Configuration Options
screen.

Note: Make sure that the default setting for the fields WinSPIRS
displays includes the *LHM and *LHC fields, to give your users ac-
cess to library holdings information.

WinSPIRS 4.0 lets you exclude holdings information for specific
databases. If you do this, holdings messages do not appear in records
from the databases you specify. This mechanism applies only to locally
mounted databases. Records from databases accessed using an ERL
server will still show holdings messages, unless holdings from these
databases are disabled at the ERL server.

To disable a database from displaying holdings messages:

1.

2.

Open winspirs.ini in a text editor.
Go to the first section, which starts with [ ].

Find tag ! 42. Delete the semi-colon (; ) at the beginning of the tag.
(This makes the tag active.)

Enter a comma-delimited list of the database families for which you
do not want holdings messages to display.

The default is for holdings messages to display for all SilverPlatter
databases. If you explicitly list in this file some subset of your data-
bases for which holdings message display is disabled, holdings mes-
sages will display only for those database families you have not
included in the list.

For example:

If your library subscribes to the following databases:

Medline Advanced (MEDS)

PsycInfo (PY)



2-14 Installing WinSPIRS

Default Holdings
Messages

*  Sociofile (SO)
*  Cinahl (NU)

you might want holdings messages to display only for Medline
Advanced and PsycInfo. So you add the following to winspirs.ini:

142=50,NU

Note: You must enter the database family names, and you must sep-
arate each with a comma.

An example line appears in winspirs.ini, commented out by an initial
semicolon.

You can enable the display of default holdings messages for situations
when WinSPIRS cannot identify a message to display from your HCU-
generated holdings file. The most common occurrence of this would be
for journals that your library does not subscribe to, although other
circumstances might also cause this.

Note: This mechanism applies only to locally mounted databases.
Records from databases accessed using an ERL server will not show
these messages. A similar mechanism is available for configuring an
ERL server to provide default messages. See the ERL Administrator s
Manual for details.

The winspirs.ini file contains a list of numeric tags and text messages
associated with various conditions that result in no holdings information
being available for display:

;150=Holdings files missing or incomplete

; !51=Holdings files have no compatible keys

;152=Holdings for this database family disabled

; 153=No holdings key field in record

;154=No holdings key found in field

; 155=The holdings key in this record is invalid

;156=Holdings index file corrupt - rebuild

; !157=No holdings information for this record

You specify which of these messages you want to display, and you can
change the text displayed.

To change the default holdings messages:

1. For any condition for which you would like a default message to
display, open the winspirs.ini file in your text editor.
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2. Delete the semi-colon (;) at the beginning of the tag which
corresponds to the condition for which you would like a default
message to display.

You can leave the text as it is, or edit the text to display any wording
you wish. If messages span multiple lines, you must type \n at the
end of each separate line of text at the point where you wish the line-
break. If you press [Enter] at the end of a line, the message will be
truncated at that point.

For example:

If you want to display a message for journals that your library does
not subscribe to, locate tag ! 57 and delete the semi-colon (; ). You
might want to replace the default text:

No holdings information for this record

with appropriate text such as:

The library does not subscribe to this\n
journal. Please ask library staff\n
for help in getting this article.

Languages

WinSPIRS 4.0 is available initially in English. Interface files for other
languages can be added when available by using the Add Language
icon.
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This chapter introduces you to the basics of using WinSPIRS:
«  Starting WinSPIRS

*  Selecting a database

*  SPIRS at a glance

*  Getting online help

* Ending a search session

You should be familiar with basic mouse techniques and WinSPIRS
conventions as outlined in the Introduction.

WinSPIRS allows you to search both full-text and bibliographic

databases. Except where specifically mentioned, the term “database”
refers to both types of database.

Starting WinSPIRS

There are several ways to start WinSPIRS. The easiest is to double-click
on the WinSPIRS icon in the folder in which it was installed.

Other methods vary depending on whether you have Windows 95 or 3.1:

*  Double-click on winspirs.exe in Windows Explorer (95) or File
Manager (3.1)

*  Run winspirs.exe from the Run command in the Taskbar’s Start
menu (95) or in the Program Manager’s File menu (3.1)
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Once you launch WinSPIRS, you can choose the databases you want to
search.

Selecting a Database

When started, WinSPIRS displays a database title screen or database
selection screen, depending on how many databases are available.

If multiple databases If you have access to multiple databases, WinSPIRS displays the
are available: Available Databases dialog.

Available Databases
Select the database or databases you want to use

Choose from these Databases:

Lacal =
1. Click to highlight sl ot e

database - CC Search(R) Life/Clin Ed. 1998/10/24-1998/10/30

a CC Search(R) Life/Clin Ed. 1998/07/01-1998/10/30

MEDLINE (R) Advanced 1994-1995
MEDLINE (R) Advanced 1992-1993
MEDLINE {R) Advanced 1990-1991
MEDLINE {R) Advanced 1988-1989

2. Click Add — — =
Use these Databases: _w7 w __79'"0\’9

Selected databases MEDLINE (R) Advanced 1996-1997
listed here—Jm

\J

" Rerun Search Histo
3. Click OK to accept Rerun Search History

selection |Qes|:ripliun| ‘ Refresh I | , OK I | Cancel | ‘ Help

FIGURE 3-1 Selecting databases
Depending on the source and type of available databases, this list
includes the server names (for databases on ERL servers), database
names, and coverage dates (if available)
To select databases from the list:

1. Click on the title of the database you want to select.

To select multiple databases, hold down [Shift] or [Ctrl] while click-
ing on the databases titles.




If only one database is
available

Selecting a Database

2. Click vvAddvv to select the highlighted database.

3-3

3. Click OK. WinSPIRS displays the first database title screen and the

Title Screen dialog box,.

About CINAHL

NURSING & ALLIED HEALTH (CINAHL (tm))-CD

NURSING & ALLIED HEALTH (CINAHL-CD is the only compact disc designed specifically to meet the information
needs of nurses and allied health professionals. Itis the database equivalentta the CUMULATIVE INDEX TO
NURSING & ALLED HEALTH LITERATURE (CINAHL). The mostwidely used indexin its field, CINAHL provides
access ta virtually all English language nursing journals, publications fram the American Nurses' Association and the
MNational League for Nursing, and primary journals from 13 allisd health disciplines

Database copyright CINAHL Information Systems 1993, All rights reserved. CINAHL Information Systems

Search and Retrieval Software Copyright of SikverPlatter International, Ny, 1990-1934; guide files, indexes and
supporting files 1989 o present.

"SilverPlatter is a registered trademark of SilerPlatter International, M. The SikerPlater logo, SFIRS, SPIRS FT,
WinSFIRE, NEC SPIRS and MacSFIRS are trademarks of SikverFlatter Intermational, MY,

SikverPlatter shall not under any circumstances be lighle forthe completeness or accuracy of the material used in this
databese orfor any injury and/or damage to persons or propery arising frorm the use or operation of any methods,
products, instructions orideas contained in or referred to in such material. SikverPlatter recommends independent
verification of all dats, especially drug regimens, dosages and side-effects.

| OK I ‘ Next | ‘Erevinugl

FIGURE 3-2 A database title screen

This screen provides the coverage dates, scope, and copyright infor-

mation for the current database.
4. Click Next and Previous to view the remaining title screens.

5. Click OK to open the Search screen and begin your search.

If only one database is available, WinSPIRS automatically displays the

database title screen, as shown above.
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WinSPIRS at a Glance

WinSPIRS consists of the following screens:

*  Search

* Index

*  Thesaurus (for databases that include a Thesaurus)

* Table of Contents (for full-text databases)

All screens include a menu bar and a button bar at the top of the screen.
From there you have access to the commands, dialog boxes, and screens

that are available to you.

Click the icons on the button bar for access to their associated functions
and screens.

Click this button: To open or move to:

M Database Available Databases dialog box
& Print Print Records dialog box
H Download Download Records dialog box
¥ Searches Search screen
] Index Index screen

Contents Table of Contents screen

[ Thesaurus Thesaurus screen

The menu bar contains the menus from which you select commands and
dialog boxes. Menus and commands vary slightly depending on which
WinSPIRS screen is displayed. Some of the menu commands are
available on the button bar or as buttons elsewhere on the screen.
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File Menu

The File menu contains commands to save and reuse your search history,
to output your search results to a disk or to a printer, and to select other
databases to search. This menu also enables you to restart or exit
WinSPIRS.

Edit Menu

The Edit menu contains commands to copy and paste text and clear the
search history or text entry area.

Utilities Menu

The Utilities menu lets you view suggested terms, view loaded
databases, and select fields to search.

Records Menu

The Records menu lets you display marked records, sort records, show
held titles, and move the cursor around the list of retrieved records.

Mark Menu

The Mark menu lets you mark and unmark records. If you are searching
a full-text database, you can mark portions of the records.

Options Menu

The Options menu lets you set (for a single search session) how
WinSPIRS prints, shows, and saves retrieved records. This menu also
lets you: show intermediate results, show hits per database (when
searching more than one), select fast phrase searching, have records
display automatically, change the color scheme, and change language
interfaces (if available).

Views Menu

The Views menu lets you move among the WinSPIRS screens, and
expand your view of portions of the screen. For example, on the Search
screen, you can expand the view of the Search History area to cover the
entire screen.
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Search Screen

Help Menu

The Help menu gives you access to the various types of help available in
WinSPIRS. “Getting Online Help” on page 3—11 provides more
information on the Help menu.

The Search screen lets you perform searches and view the records
retrieved by those searches. The major components of this screen are
labeled in the figure below. For more detail about using the Search
screen, see “Using the Search Screen” on page 4-2.

1} WinSPIRS 4.0 - CINAHL 1 [=] E3

Menu bar—» File Edit Lliles Becords Mark Options Views Help
Bution bar—ype | ®Datebase | @Prnt ||EDowniond | [ searches |[Elindex |[Ficonci: |[EThesaus |

Search: text entry area _»Seargh: Ihlatus hernia | Search I Suggest I
" No. Records Search Search HiSlOfy

Search History area—|

#1 10 hiatug = Show
# 153 hernia — 4
#3 7 hiatus hernia Limit._.

CINAHL

Retrieved Records status area_ym | 107 in search i

Retrieved Records area ]

TI: The dietary management of gastrointestinal reflux and hiatus hernis
AU: gtening-L
#0: New-Zealand-Practice-Nurse (NZ-PRACT-NURSE) 1995 May; { )= 3B-9
AN: 1925034535

TI: Hiatus hernia and reflux esophagitis
AU: gpiro-HM
80: Hospital-Practice (HOSP-PRACT) 1994 Jan 15; 29(1): 51-4, 61, 65-6 (%
bib}

| Next Hit || Prewvious Hit I | All Fields | ‘ Show Full Text ” Add to Search | I |

FIGURE 3-3 WinSPIRS Search screen

To perform a search, type a term in the Search: text entry area and click
Search. WinSPIRS lists the search in the Search History area and
displays the records containing your search terms in the Retrieved
Records area.

The Search History area is a list of searches performed during a session.
Each line in the Search History shows one search and the number of
records it retrieved.

The Retrieved Records status area provides information about the active
record including the database name and the number of the active record,



Index Screen

Menu bar—»Elle Edit Utiliies Becords Mark Opfions  Yiews Help
Button bar_»‘@-Dﬂtﬂbase ”%Prinl ”EDuwnluﬁd I |$ Searches Illndgx HCunlenls ”Thesaurus

Index: text entry area‘*atus Change... |

Index Terms area—

Retrieved Records status area4>| CINAHL

Retrieved Records area |
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for example / of 7 in search #1. The active record is indicated by a
blinking cursor.

The left side of the Retrieved Records area is the record-marking area. In
this portion of the screen, each record is identified with a book icon. You
can click on this icon to mark the record for later printing or
downloading.

The Index screen lets you look for particular terms and view the records
that include those terms. The major components of this screen are labeled
in the figure below. For detailed information about using the Index
screen, see “Using the Index” on page 4-14.

To display the Index screen, click Index on the button bar, choose Index
from the Views menu, or press [F5].

I WinSPIRS 4.0 - CINAHL M= B3

Index: (*F - Free Text Index) Look Up

Records Occs Entry Index IE"TIS

Show
1 1 HIAYWATHA 1
35 54 HE Sanichi|
15 15 HIB-YACCINE
1 1 HIB-YACCINE-ADMINISTRATION-AND-DOSAGE
5 ] HIE-YACCINE-ADMINISTRATION-AMND-DOSAGE-IN-INFAMCY-AND-C >

1 of 10 matching HIATUS

TI: The role of the cruciate and posterolateral ligaments in stability of
the knee: a biomechanical study
AU: Veltri-DM; Deng-X; Torzilli-PA&; Warren-RF; Maynard-MJ
20: American-Journal-of-#ports-Medicine (AM-J-SPORTS-MED) 1995 Jul-dug; 23 (
4): 436-43 (20 ref)
8I: Az4340000
AN: 1936006763

[d r7: The dietary management nf gastrointestinal reflux and hiatus hernia

AU: Stening-L

‘ Next Hit || Previous Hit | ‘ All Fields || Show Full Text || Add to Search I I |

FIGURE 3-4 Index Screen

To look up a term, type it in the Index: text entry area. The Index Terms
area scrolls to find the closest match to your term.

When you find a term, you can show the records in which the term is
found in the Retrieved Records area or search for the term (which returns
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you to the Search screen.) You can select and search for multiple terms.
You can also change indexes.



Thesaurus Screen

Thesaurus: text entry area— Jmrhacayrus: I

Permuted Index ™|
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Many databases include a thesaurus: a list of controlled vocabulary used
to standardize the indexing in the database. This lets you select and
search for synonyms and preferred terms, and also to see descriptions of
the terms. Also, if the database’s thesaurus is arranged hierarchically,
you can select more general and more specific terms. For detailed
information about using the Thesaurus screen, see “Using the
Thesaurus” on page 4—17.

Note: If you are searching multiple databases from different database
families, the Thesaurus is unavailable.

To display the Thesaurus screen, click Thesaurus on the button bar,
choose Thesaurus from the Views menu, or press [F9].

s WinSPIRS 4.0 - CINAHL
Eile Edit Utilities Options Yiews Help

|@- Database I |é Print I |E Download I |$ Searches I | Index I ‘Cumenls I |Thgga|‘n‘5

1S [=] E3

Look Up I

Permuted Index

HIATUS =1 | Term Information

Hiatus Hernia see Hernia, Diaphragmatic 1

IHIE :ﬂmk ‘
HIB Vacc!ne Search Options—
HIB *accines see HIB Vaccine

HIBICLENS ® Single Term
Hibiclens see Chlorhexidine

Hiccup C Explode
Hiccup b

HICCUPS
Hiccups see Hiccup

HICKMAN - |
Hickman Catheter see Catheters, Wascular
Hickman Catheters see Catheters, Vascular —

HIERARCHY @
Maslows Hierarchy of Need see Maslow's Hierarchy of Needs ]
Wlaslow's Hierarchy of Needs View List...
Maslows Hierarchy of Meeds see Maslow's Hierarchy of Meeds ;

HIGH _l;l

4 r

FIGURE 3-5 Thesaurus displaying the Permuted Index

To look up a term, type it in the Thesaurus: text entry area and click the
Look Up button. The Permuted Index scrolls to find the closest match to
your term.

You can view the index of thesaurus terms, get a brief description of the
term and how it is used in the thesaurus, and select terms and search for
records containing them.
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Table of Contents
Screen

Highest level of data- —
base Table of Contents ™.

Book indicates a record g

Page indicates a section

Associated record

Full-text databases are organized into hierarchies that you can view on
the Table of Contents screen. For detailed information about using the
Table of Contents screen, see “Using the Table of Contents” on page 4—
25.

To display the Table of Contents screen, click Contents on the button
bar, choose Table of Contents from the Views menu, or press [F3].

' WinSPIRS 4.0 - 0SH-CD M= E
Eile

Edit Utiliies Becords Mark Opfions  Yiews Help

|@- Database I |é Print I |E Download I |$ Searches I | Index I | Contents | |Thesﬁurus I

Table of Contents | GUIDANCE AND AD.. : Advsory and Joint Standing C... : ASBES

S =

gk LEGISLATION - S
EINTERPRETATIONS OF THE LEGISLATION L :

r

SGUIDANCE AND ADVICE Contract |
= Advisory and Joint Standing Committee Reports

=ASBESTOS, Advisory Committee on s Al J

=ASBESTOS - FINAL REPORT, vOL. 2

D Bibliographical Reference

= ce

THE IL1-FFFFECTS NF ASBESTOS O HEAITH { F N Acheson and M1 G‘arrlnnr_';l
»

0SH-CD : ASBESTOS - FINAL REPORT, YOL. 2 : Preface

Preface

+
¥ 1his volume contains papers commissionsd by the Advisory Committes and used
in preparing their final report.

THE ILL EFFECTS OF ASEBESTOS UPON HEALTH by E D Acheson and M J Gardner is
the full report from which the agreed summary at Chapter 3 in Volume 1 is
drawn. Material from ASBESTOS CONTROL LIMITE by J Steel is incorporated
more fullwv into the main text but is particularlv relevant to Chanters 3

| Next Hit | [ revious Hit | | BrietFields || Addta Search |[ change ToC | [EN

FIGURE 3-6 Table of Contents screen

To locate a record in the Table of Contents, you can expand the

appropriate branches until you reach the level of the record, identified
with the book icon.

You can also display the contents of individual records in the Table of

Contents area. You can then select the portion of the record you want to
view.
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Getting Online Help

Displaying Online
Help

Getting Database-
Specific Help

Online help is available both for WinSPIRS and for the databases you are
searching. You can get context sensitive help for screen areas and dialog
boxes. By using the Help menu, you can get help on all menu items,
WinSPIRS commands, and search techniques through a variety of topics
from which you can choose. You can access database guides:
information specific to the database you are using, and you can even get
help on how to use the help system.

Press [F1] or click Help to access context sensitive help, or use the Help
menu to move through Help topics.

F-WinSPIRS Help [ [O]x]
File Edit Bookmark Help

Qunlentsl Search | Back | History |g|nssavy| Index |

WiInSPIRS Basics

WinSPIRS lets you search databases for records j
containing terms you specify. You can then show,

print, or download these records. Below are some of

the basic operations you can perform in WinSPIRS.

Selecting Databases
Select different discs or databases to search.

Customizing WinSPIRS
Customize the WinSPIRS display to suit your
needs. 3

------ Dawnload records and graphics to a floppy or hard
disk.

Exiting WinSPIRS
Leave Y¥inSPIRS and return to Yindows.

Print your retrieved records and any graphics linked =]

FIGURE 3-7 A typical help window

The WinSPIRS help system uses Windows standards; if you have used
any other Windows applications, you may be familiar with the help
system.

Click Contents for a hierarchical list of help topics, or Index for an
alphabetical list. Click Search to search a list of keywords.

Each SilverPlatter database comes with a guide, help information unique
to that database. To see the guide for the database you are using, choose
Guide from the Help menu.
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For each loaded database you will see two entries in the Guide submenu.

WinZPIRS Help Index
Using the Thesaurus
WinSPIRS Basics
Ienu Help

Help an Help

About'WinSFIRS. . 2 CINAHL Fields

License agreement |

FIGURE 3-8 A typical Guide submenu

The first choice displays a list of all topics covered in the database guide.
The second choice displays all the fields in the database. Some of the
topics typically included in the guide, in addition to the fields, are an
introduction to the database, sample searches, lists of special codes, and
a list of stopwords.

Ending a Search Session

When you are finished searching, you can either exit WinSPIRS or
restart to leave it ready for the next user.

To exit WinSPIRS, choose Exit from the File menu.
To restart, choose Restart....

In either case, you are given the opportunity to save marked records or
your search history before closing WinSPIRS.
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Searching with WinSPIRS

You can search for records in a variety of ways, depending on your
search concepts, the database you are searching, and your preference.
The first part of this chapter illustrates the various techniques of using the
Search screen:

*  Performing a Simple Search

*  Valid Search Statements

*  Using Truncation and Wildcards

»  Searching for Hyphenated Phrases

*  Using Parentheses

*  Combining Terms with Operators

*  Searching in Specific Fields

*  Searching in Limit Fields

*  Searching SGML Full Text

+  Using the Suggest Feature

The second part of the chapter addresses some of the more advanced
WinSPIRS functions:

*  Using the Index
*  Using the Thesaurus

*  Using the Table of Contents
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»  Using the Search History
*  Using Current Awareness Searches: SDIs and Alerts
*  Searching Multiple Databases

+  Narrowing and Broadening Your Search

Using the Search Screen

Performing a Simple
Search

The first step in a search is to decide what you are searching for. Identify
terms or concepts that describe your search objective. Once you have
your topic, think of the search terms that represent the search topic.

Next, evaluate your search terms in relation to the database: do they
adequately describe the topic? Will they be too specific or too general?
The answers to these questions depend on many factors including the
scope of the database you choose to search.

Once you identify the objective of your search, you can determine how
to search the database. The simplest way to search is described below.

To search for a term or phrase:

1. Type a term in the Search: text entry area.

' WinSPIRS 4.0 - CINAHL =] 3
File Edit Utilties Records Mark Options Yiews Help

|~@} Database I|% Print I|E Download I |% Soaichos || Index ”Cumenls I|Thesaurus I
Search: |hiatu5 hernia

FIGURE 4-1 Searching

2. Click Search. WinSPIRS lists the results of your search in the
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Search History.
No. Records Se;arc:h - - : . Séarcﬁ Hlslory b b
#l 10 hiatus = | Show
#2 159 hermia —
3 7

hiatus hernia Limit...
Retype

= Clear...

FIGURE 4-2 Results of a simple search

Note that the results of the individual terms of a phrase are included
if you have Show Intermediate Results turned on in the Options
menu.

3. Ifnecessary, click Show in the Search History. WinSPIRS displays
the records retrieved by your search.

A s
1 of 7 in search #3

TI: The dietary management of gastrointestinal reflux and histus hernis
AU: Stening-L

#0: New-Zealand-Fractice-Nurse (NZ-PRACT-NURSE) 1995 May; { ): 38-9
AN: 1985034535

TI: Hiatus hernis and reflux esophagitis
AU: Spiro-HM
#0: Hospital-Practice (HOSP-PRACT) 1994 Jan 15; 29(1): 51-4, 61, 85-6 (2
bib)

[ Next Hit | [ Erevious it | | AnFieids || Show Full Text || Add to Search | = |

FIGURE 4-3 Records retrieved by a search

Note that the records are displayed automatically if you have
Automatic Records Display turned on in the Options menu.

Refer to the following sections in this chapter for information on refining
your search. Remember online help is available: press [F1] or use the
Help menu.

Below are examples of search requests that you can type in the Find
Records dialog box. Each request can be up to 1024 characters long.

Description of Search Example

Aterm dog
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Using Truncation and
Wildcards

Searching for
Hyphenated Phrases

Description of Search Example
A term with truncation comput*
A term with wildcards colo?r
A number 1994

Letters and numbers combined 3m

A phrase new york city

A hyphenated phrase drug-abuse

A phrase with operators in quotes “near” death experience
A term or phrase limited to a field smith in au

A previous search request #3
number

Any of the above, combined with 3m and #2
operators

Any of the above, separated by  drug-abuse; #4;smith in au
semi-colons

Any of the above, grouped (canine or #1) near puppy
with parentheses for clarity

You can retrieve variations of a search term by using truncation and
wildcards. This is a useful way of broadening a search that has retrieved
too few records.

The truncation symbol (¥) serves as a substitute for any string of zero or
more characters. For example, type cardio* to retrieve cardiology,
cardiogram, etc.

The wildcard symbol (?) serves as a substitute for one character or none.
For example, type m?cdonald to retrieve McDonald or MacDonald.

The truncation and wildcard symbols can be used anywhere in your
search term, except as the first character.

Often, when a database is set up, the individual words of a phrase are
“bound” with hyphens so that the complete phrase can be indexed, rather
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than just the individual words. For example, authors’ names are
hyphenated so that the first and last names are kept together in the Index.
Similarly, controlled vocabulary terms, such as descriptors, are
hyphenated so that key phrases are kept intact.

When searching a field that uses hyphens, you can include them in or
omit them from your search request to make the search more or less
focused. To determine which fields use hyphens, take note of the fields
in a retrieved record or refer to the database Guide in the Help menu.

Including Hyphens for a Focused Search

If the field you are searching uses hyphens, you can hyphenate your
search term to retrieve only occurrences of that term.

For example, if you are searching the Descriptors (DE) field, the search
request marine—-aquaculture in de retrieves only occurrences

of marine-aquaculture. Similarly, in the Authors (AU) field, the search
lindeman-c in au retrieves only records authored by C. Lindeman.

Alternatively, you can select hyphenated phrases from the Index. See
“Using the Index” on page 4—14 for more information.

Omitting Hyphens for a Broad Search

If the field you are searching uses hyphens, you can omit them from your
search term to retrieve variations of your term. For example, if you are
searching the Descriptors (DE) field, the search request

marine in de retrieves occurrences of marine, marine-aquaculture,
marine-crustaceans, marine-environments, and so on. Similarly, in the
Authors (AU) field, the search 1indeman in au retrieves records
authored by 4.K. Lindeman, C. Lindeman, C.A. Lindeman, and so on.

Use parentheses to avoid ambiguity in complex search statements.

For example, suppose you want to retrieve records that discuss rabies in
dogs or rabies in cats.

The search request rabies and dogs or cats retrieves records
that discuss rabies and dogs, and records that discuss cats, but not
necessarily records that discuss rabies and cats.

The searchrequest rabies and (dogs or cats) retrieves records
that discuss rabies and either dogs or cats, which is what you intended.
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Combining Terms
with Operators

If you omit parentheses from a complex search statement, WinSPIRS
automatically inserts them. Check the Search History window to see if
WinSPIRS’ interpretation is what you intended. If it is not, click Cancel
to stop the search and edit the search request.

Operators are words that have a special meaning in WinSPIRS. You can
use them to combine search terms into a more complex search statement.

Operator What It finds

and Records that contain both of two search terms.

For example, dyslexia and child retrieves
records containing both dyslexia and child.

dyslexia child

Shaded area represents records containing the term
dyslexia and the term child

with Records that contain both of two search terms in the
same field.

For example, the search dyslexia with
research retrieves records that contain both
dyslexia and research in any one of the database
fields.

near Records that contain both of two search terms in the
same sentence.

For example, dyslexia near treatment
retrieves only those records where dyslexia and
treatment are in the same sentence (either term can
appear first).

You can add a number to near to specify exactly how
close the terms should be. For example, 1anguage
near2 computer retrieves records containing
language within two words of computer, in any order,
in the same sentence.

(Sheet 1 of 3)
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Operator

What It finds

adj

or

Records that contain two adjacent terms in the order
you specify.

For example, the focus of the search "racing
bicycle" is different from that of "bicycle
racing." The adjacent operator means WinSPIRS
searches for the two terms in the order you specify,
thus preserving the focus of your search.

adj also lets you search for identical, adjacent terms,
suchas"gorilla adj gorilla." Thisis useful for
searching biological classifications, in which several
organisms have identical genus and species names,
such as "bufo bufo."

You cannot use adj to combine the current search
with a previous one.

Records that contain either or both of two search
terms.

For example, the search dyslexia or learning
disabilities retrieves all records that contain
dyslexia, learning disabilities, or both dyslexia and
learning disabilities.

dyslexia learning

Shaded areas represent records containing the term
dyslexia or the term learning disabilities

(Sheet 2 of 3)
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Operator What It finds

not Records that contain the first of two search terms, but
not the second. This can be helpful for eliminating
false hits.

For example, t r uman not capot e retrieves
records that contain Truman and do not contain
Capote (references to the president but not the writer.)

not should be used carefully, however, because it
can also eliminate useful records.

For example, if you search for dog not puppy, you
will miss records that discuss both dog and puppy.

relevant records
eliminated

dog puppy

Grey area represents records retrieved by dog not
puppy; Black area represents relevant records
eliminated by dog not puppy

(Sheet 3 of 3)

To combine terms with an operator:
1. Enter your first term in the Search: text entry area.
2. Type the operator you want to use after your first term.

3. Enter your second term after the operator.

U WinSPIRS 4.0 - CINAHL =] B3
File Edit Utlites Records Mark Options Views Help

‘QDﬂlahase I ‘%Print I ‘Eannlnad | |$ Searches ‘ |Ind9x I ‘Cnntems I |Thesaurus |
Search: |dy5\e><ia or learning disabilities 3,_,9995.'

FIGURE 4-4 Searching for either of two synonyms
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You can narrow your search by limiting it to a particular field or group
of fields in the database. By searching only in relevant fields, you can
eliminate false hits.

For example, suppose you are looking for the works of a particular

author. Rather than search the entire database, you can search only those

fields that contain author information, such as the Author (AU) and

Corporate Author (CA) fields.

To search in a specific field:

1.

2.

In the Search: text entry area, type a term or phrase followed by in
and the label of the field you want to search.

For example, to search for Freud in the Author (AU) field, type

freud in au.

To search in multiple fields, separate the labels with commas, such

as freud in au, su.

Click Search.

You can also select field labels from a list and add them to your search:

1.

Select Fields to Search... from the Utilities menu. WinSPIRS
displays the Field List dialog.

Field List [x]

Available Fields:

DETault (1L A, CAAD, S0 SEAB, T O, 4]
G T ATION (T AU S0 5 ARG
TI-TITLE |
AU - AUTHOR(S)

A4 - AUTHOR AFFILIATION

Ci - CORPORATE AUTHOR(S)

AD - PRODUCER ADDRESS

S0 - SOURCE (BIBLIOGRAPHIC CITATION)
SE - SERIES TITLE

Gl- SERIAL IDENTIFIER =
gy _"_I

Add To Search

Cancel

Description

il

FIGURE 4-5 Field List dialog box

Highlight the fields in which you want to search and click Add to

Search.
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Searching in Limit
Fields

Field-specific indices also provide a way to search particular fields. For
more information, see “Using the Index” on page 4-14.

Each database contains several specially indexed fields called limit
fields. Limit fields typically contain information common to a large
number of records, such as publication year or language. A limit field
search can be very helpful in combination with other search statements.

When you search for terms in limit fields, you must use the field label,
along with the in operator, the = operator, or, if the limit field contains
numeric data, one of the range operators described in the table below.

For example, to search for articles published in French, you might search
the Language (LA) field as follows: french in la or
la=french.

In limit fields that contain numeric values, such as publication year, you
can also use the following special range operators:

Operator What it Means Search Example
< less than py<1986

> greater than py>1984

<= less than or equal py<=1985

>= greater than or equal py>=1984

- within a range py=1983-1986

Note: When you search without specifying a field (such as the statement
french), or if you search from the free-text index, limit fields are not
searched.

Limit fields vary according to the database. Click Limit... in the Search
History area for a list of the limit fields in the database you are using or
refer to the online Guide.

You can perform a limit search by entering your search statement in the
Search: text entry area or by selecting a search from the Search History
and applying a limit search.

1. Click on a search listed in the Search History.
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2. Click Limit... to display the Limit Search dialog box.

Limit Search
Limit Search By: Limiting Values:
SI- SERIAL IDENTIFIER [+] ® Equals A00330000
SB - JOURNAL SUBSET
PY - PUBLICATION YEAR C' Greater Than
DT - DOCUMENT TYFE
LA - LANGUAGE O Less Than
N - NLM NUMBER
SN - INTERMNATIONAL STANDARD = O Greater or Equal to A07665000
BN - INTERMATIONAL STANDARD E_ A07695000
J T T 5 C Less or Equal to

This is the new search being built:
|#7 AND Sl = "A00330000"

| OK I ‘ Cancel | | Help |

FIGURE 4-6 Limit Search dialog box

3. Select a limit field from the Limit Search By: portion of the dialog
box.

4. Select the limit operator you want to use, such as Equals.

5. Select a limiting value from the Limiting Values: portion of the
dialog box. The search you are constructing appears at the bottom of
the dialog box.

6. Click OK.

WinSPIRS performs the search and displays the results in the Search
History and Retrieved Records areas of the Search screen.

Searching SGML Full Text

WinSPIRS 4.0 includes support for SGML full text databases. SGML, or
Standard Generalized Markup Language, is an ISO standard that
provides methods for representing structured documents in electronic
form. You can search the bibliographic portions of SGML records as you
do non-SGML records. You can also browse the database Table of
Contents, and you can search specific elements of SGML full text. For
more details about Table of Contents, see “Browsing an SGML Table of
Contents” on page 4-27
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SGML records include “elements”, which are sub-fields of the Full Text
field. Elements allow you to search specific portions of the full text, such
as tables and section headings.

To search SGML full text:

1.

Select Full Text Search from the Utilities menu, or click Full Text
Search on the Full Text window, to display the Full Text Search
dialog box.

Full Text Search
Enter a term and select an element(s). then click on Search Now
Term:

Clear

Iprimﬂly care

Cancel
Element List:

UNIVERSAL: —
Footnote Text Description
Full Text Titles
Sub Headings

Health-CD_Collection 04/97:
Entry Term
Footnote Text
Full Text Titles

Publication Date

References

Surnames =1

|»

This is the new search being built:

primary care IN ORGNAME:HM

FIGURE 4-7 Searching a portion of SGML full text

The Element List lists all the elements in any SGML databases you
are searching. If you are searching more than one, the elements that
are common to all the databases are listed under the heading “UNI-
VERSAL”, and unique elements are listed under the database in
which they occur.

Type aterm in the Term: text entry box. WinSPIRS adds the term to
the search box at the bottom of the dialog box.

In the Element List, click on any elements in which you want to
search. WinSPIRS highlights the selected elements and adds them to
your search.

If you select a database-specific element, WinSPIRS appends a two-
letter database code to the element in your search, such as “:HM” in
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the example in FIGURE 4-7.

4. Ifyou have a single element highlighted, you can click Description
for a brief definition of the element.

5. Click Search Now. WinSPIRS performs the search and lists the
results in the Search screen.

Using the Suggest Feature

The Suggest feature, or Automatic Subject Lookup, provides you with a
list of suggested terms related to your search request. These suggested
terms are taken from the database’s controlled vocabulary and appear in
a window that lets you search or display definitions.

Suggested terms are available only with certain SilverPlatter databases,
and only if you are searching a single database. The Suggest button is
grayed out if the feature is unavailable.

To use the Suggest feature:

1. Type a word or phrase in the Search: text entry area.

2. Click Suggest. WinSPIRS displays a list of suggested terms in the
Suggestions dialog box.

Suggestions

]

The term you searched is HERNIA.

The following terms from the controlled
vocabulary (thesaurus) may yield better results in
a search. Choose one term to search.

Hernia-Inguinal
Surgery-Laparoscopic
Hemia Explode
Hemia-Diaphragmatic
Abnormalities

Search

Close

Nursing-Process
Patient

Pediatric
Adolescent-Health
Aged-Hospitalized

Definition...

FIGURE 4-8 Suggestions for the term “hernia”

3. Click on a suggested term.
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Using the Index

Looking Up an Index
Term

4. Click Definition to display a description for the highlighted term.
5. Search for the suggested term:

»  Click Search to search for the term without any narrower
terms.

*  Click Explode to search for the term and all its narrower
terms. (Note: Exploding is unavailable if the database does
not have a hierarchical thesaurus.)

The Index lists all the searchable terms in the database and indicates the
number of records that contain each term. Many databases have more
than one index. For example, a database can have an index for the Author
field, and a separate index for the Title field. The Index is especially
useful for finding hyphenated phrases and variations of authors’ names.

Note: Words that appear too frequently to be used in searching are

omitted from the Index; these are called “stopwords” and are listed in the
database Guide in the Help menu.

To look up an index term:
1. Click Index on the button bar. WinSPIRS displays the Index screen.

2. Type a term in the Index: text entry area.

1 WinSPIRS 4.0 - CINAHL =] E3
File Edit Lhilites Becords Mark Options Views Help

|QDatabase ”%Plim ||EDDwn|Dﬂd I |$ Searches ”Index HCDntems I|Thesaulus |
Index: (*F-Free TextIndex) Look Up

|coronary Changa..

FIGURE 4-9 Looking up “coronary” in the Index

WinSPIRS displays the Index Terms, with your term, or its closest
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match, highlighted.

Records Occs Index Ierms

358 CORONARY Show

1 1 CORONARY- =

o5 =8 CORONARY-ANGIOGRAPHY SeachE|
4 1 CORONARY-ANGIOGRAPHY-ADVERSE-EFFECTS

1 1 CORONARY-ANGIOGRAPHY.IN-OLD-AGE

1 1 COROMARY-ANGIOGRAPHY-METHODS -

FIGURE 4-10 Index Terms
3. Scroll through the Index Terms. For each term, WinSPIRS displays
the number of records that contain the term and the total number of
occurrences of the term.

4. Click on any term of interest. WinSPIRS highlights the term.

5. Click Show to preview the records that contain the term. (Show is
grayed out if you have more than one term selected.)

CINAHL
1 of 3358 matching CORONARY

IE TI: Cardisc Surgery: Multidisciplinary Care Flan & Education Plan
30: Glendale aAdventist Medical Center, 1502 Wilson Terrace, Glendale CA
91206-4007; Phone: (218) 405-8007 1955 Dec (2 p)
AN: 159960135Z0

TI: Critical Pathway for Patient and Family: Cardiac Surgery
20: Glendale Adventist Medical Center, 1509 Wilson Terrace, Glendale Ca
91206-4007; Phone: (B818) 409-8007 1995 Dec (1 p)
AN: 15956013517

M mr. raranars ssrve

| Next Hit || Previous Hit I ‘ All Fields || Show Full Text || Add to Search I =

FIGURE 4-11 Records containing the index term “coronary”

You can scroll through the records, change their display, and print
and download them as with records in the Search screen, but the in-

dex terms are not added to your search history until you search for
them, as described below.

Searching for Index You can preview, print, and download records that contain a particular

Terms index term, but the term is not added to the Search History until you
search for the term. After you search for an index term, you can combine
the search with other searches, limit the records retrieved by the search,
and save the search as part of your Search History.
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Searching with WinSPIRS

To search for index terms:

Select one or more terms. To select multiple terms, press [Shift] or
[Ctrl] and click on the desired terms

Occs Entry Index Terms
7 ONARY Show

Search

FIGURE 4-12 Searching for multiple terms in the Index

Click Search. WinSPIRS adds the term(s) to the Search History. If
you select multiple terms, WinSPIRS combines them with the or

operator.

If the database you are searching has more than one index, you can
change indexes as follows:

Click Change... or choose Change Index... from the Options menu.
WinSPIRS displays the Available Indexes dialog box

Available Indexes

5B - JOURNAL SUBSET
P - PUBLICATION YEAR: L
LA - LAMGUAGE
UD - UPDATE CODE
CP- COUNTRY OF PUBLICATION
FT - PUBLICATION TYPE

AR LY
5I- SERIAL IDENTIFIER L

FIGURE 4-13 Selecting an index

The Free Text Index is listed first and is the default. It indexes the
fields listed in parentheses, and is a good index to search if you don’t
want to limit your search to a specific field.

If you are searching more than one database, the indexes that are
common to all the databases are listed under the heading “UNIVER-
SAL”, and unique indexes are listed under the database in which
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they occur.
2. Click on the desired index.

You can select more than one field-specific index by holding down
[Shift] or [Ctrl] and clicking on the indexes you want to search.
However, the Free-Text index can only be searched by itself.

3. Click Select to select the index(es) you want to search and to return
to the Index screen. The names of the selected indexes appear in
parentheses next to the Index: prompt.

Using the Thesaurus

Looking Up a
Thesaurus Term

Many databases include a thesaurus, which is a list of controlled
vocabulary terms used to standardize the indexing in the database. The
Thesaurus enables you to select and search for synonyms, related terms,
and preferred terms. If the thesaurus is arranged hierarchically, you can
select more general (broader) and more specific (narrower) terms.

To look up a thesaurus term:

1. Click Thesaurus on the button bar. WinSPIRS displays the
Thesaurus screen.

2. Type a term in the Thesaurus: text entry area

" WinSPIRS 4.0 - CINAHL =] E3
File Edit Utlites Options Yiews Help

‘QDﬂlabﬂse ”%Plint ”EDuwnlnﬂd | ‘%Searches ”Index I|Cnntents ||Thesﬂurus |
Thesaurus: |hem\a [Lookup]

FIGURE 4-14 Looking up a tem in the Thesaurus

3. Click Look Up. WinSPIRS displays the Permuted Index, with your
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Getting Information
about a Thesaurus
Term

term or its closest match highlighted.

Pérmutéd VIndéx 7

HERMIA =
Diaphragmatic Hernia see Hernia, Diaphragmatic
Hermia, Diaphragmatic
Hermia Diaphragmatic see Hernia, Diaphragmatic
Heria, Hiatal see Hernia, Diaphragmatic
Hemia, Inguinal
Hemia Inguinal see Hernia, Inguinal
Hemia, Umbilical
Hemia Urmbilical see Hernia, Umbilical
Hiatal Hernia see Hernia, Diaphragmatic
Hiatus Hemia see Heria, Diaphragmatic
Inguinal Hernia see Hernia, Inguinal
Umbilical Hernia see Hernia, Umbilical

HERMIATED
Disk, Herniated see Intervertebral Disk Displacement
Hemiated Disk see Intervertebral Disk Displacerment

HEROIN

Heroin il
»

Term Information
Back

Search Options—

@ Single Term

O Explode

Add to List...

View List...

FIGURE 4-15 Permuted Index, showing the descriptor phrases in which

the term occurs

4. Scroll through the Permuted Index. It lists all the descriptor phrases

in which each controlled vocabulary term occurs. You can get
information and search for any term of interest, and you can add

terms to a list for batch searching.

The WinSPIRS Thesaurus includes a Term Information section, which
provides details about a selected thesaurus term. The information

provided depends on the database you are searching. It often includes a

definition, scope notes, previous indexing terms, and related, broader,

and narrower terms.

To get information about a thesaurus term:

1. Ifnecessary, look up aterm in the Thesaurus as described on page

4-17.

2. Click on a term in the Permuted Index.

3. Click Term Information. WinSPIRS displays the Term Information




Notes, related terms

Broader term

Narrower terms
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screen.
4 WinSPIRS 4.0 - CINAHL [H[=] E3
Eile Edit Utilites Opfions  Yiews Help
‘@Dﬂlﬁhﬂse I ‘%Plim I ‘Eannlnad | ‘% Searches I ‘Index I | Contents | |Thgsﬂuru5 |

Thesaurus: |hem\8 Look Up |

Term Information

Hernia . 1| Term Information
DEFINITIOM OF TERM: Protrusion of a loop or knuckle of an organ or tissue through an abnormal !

opening. Back

Search Options—

Uzed For. Enterocele
(0] Single Term

@ Explode
TREE 1 of 2. Digestive System Diseases in all trees
Gastrointestinal Diseases C Explode in
tree #1

Hernia, Diaphragmatic
rnia, | I

B
Hernia, Umbilical

. Add to List...
TREE 2 of 2: Symptoms and General Pathology (Mon-Cinahl) |
Hernia View List...

FIGURE 4-16 Term Information, showing term notes, related terms, and
tree structure (broader and narrower terms)

You can search for the term, add the term to a list to search for later,
or get information on another term.

Displaying Trees

Some thesauri display broader and narrower terms in a hierarchical
structure called a “tree.” Trees are shown in abbreviated form in the
Term Information screen.

To display the complete trees:

1. Ifnecessary, get information about a term as described above.

2. Seclect View Full Tree from the Options menu. WinSPIRS displays
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Lower numbers indicate
broader, more general terms

Higher numbers indicate
narrower, more specific terms

Searching for
Thesaurus Terms

the Full Tree View screen.

4 WinSPIRS 4.0 - CINAHL [H[=] E3
Eile Edit Utilites Opfions  Yiews Help
‘@Dﬂlﬁhﬂse I ‘%Plim I ‘Eannlnad | ‘% Searches I ‘Index I | Contents | |Thgsﬂuru5 |

Thesaurus: |hem\8

Look Up

Full Tree View

_____________ Hematemesis =1| Term Information

----Melena
,,,,,,,,,, Gastraintestinal Meoplasms Back

. Search Options—
E. S Hernia, Diaphragmatic
4. .. Hernia, Inguinal @® Single Term
I D Hernia, Umbilical =
(G Intestinal Diseases 5
4. ----Cecal Diseases ® Ealahm
5 ____Appendicitis itz &
M Colonic Diseases
R
G. ... Colitis, Ulcerative
6. -- Enterocolitis Add to List._.
. Enteruculltm: Eseudum.er!wbranuus ‘E
L Enterocolitis, Necrotizing

_ Colonic Neoplasms
_Diverticulosis, Colonic

5 Megacolon s
4 »

FIGURE 4-17 Full Tree View, showing the broader and narrower terms
for “kidney”

The column of numbers on the left side of the tree indicates the level
of each term in the tree. Broader, more general terms are indicated
by lower numbers, and are listed further left than narrower, more
specific terms.

You can search for, get information on, or add to a list any term in
the tree.

WinSPIRS allows you to search for thesaurus terms directly from the
Permuted Index, Term Information, and Full Tree View screens. Once
you select a term, you can search for it individually, or you can add it to
a list of thesaurus terms for batch searching.

To search for thesaurus terms:

1. Select any term of interest in the Permuted Index, Term Information,
or Full Tree View screen.
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In the Search Options box, choose the type of search you want to
perform:

*  Select Single Term to search for the selected term without its
narrower terms.

*  Select Explode to search for the selected term along with its
narrower, more specific terms. This is more comprehensive
than searching for the term by itself. (If the thesaurus is
organized into trees, you may be able to select the tree in which
to explode the term.)

Click Search Now to perform the search, or click Add to List to add
it to a list of searches to perform later.

If the thesaurus you are searching uses subheadings, WinSPIRS
displays the Subheadings Selection dialog box. Select one or more
subheadings and click OK. See “Selecting Subheadings” on page 4—
21 for instructions.

If you chose Search Now, WinSPIRS copies the term, and any
subheadings, to the Search screen and performs the search.

If you chose Add to List, WinSPIRS copies the term, and any sub-
headings, to the Selected Term List. You can then view the list, add
more searches to it, or perform all of the searches.

If You Have Built a List of Searches

Once you add a search to the Selected Term List, you can view the list,
add more searches to it, or perform all of the searches.

To view the list:

Click View List... in the Permuted Index, Term Information, or Full
Tree View screen. WinSPIRS displays the Selected Term List dialog
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box

Selected Term List [x]

Selected Terms Selected Subheadings

NONE - Term without subheadings -
Cl - CHEMICALLY INDUCED

CL - CLASSIFICATION

CO - COMPLICATIONS

DH - DIET THERAPY

DI - DIAGNOSIS

DT - DRUG THERAPY

EC - ECONOMICS

ED - EDUCATION

EH - ETHNOLOGY

EP - EPIDEMIOLOGY

ET - ETIOLOGY =
AL - I>I_I

| Change Subheadings | | Search List |

| OK I | Cancel | | Help |

FIGURE 4-18 Selected Term List with subheadings
To delete searches from the list:
1. Click on a search in the Selected Term List.

2. Click Clear. WinSPIRS deletes the term and any subheadings
selected for that term.

To perform the searches:

*  Click Search List in the Selected Term List dialog box. (You can
also click Search List in the Permuted Index, Term Information,
and Full Tree View screens.) WinSPIRS performs all of the searches
and discards the list.

Selecting Subheadings

Subheadings are qualifiers used in some thesauri to describe specific

aspects of terms. If the database uses subheadings, you need to apply one

or more to your term before searching for the term.

To select subheadings:

1. When you click Search Now or Add to List in the Permuted Index,
Term Information, or Full Tree View screen, WinSPIRS displays
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the Subheadings Selection dialog box.

Subheadings Selection with Age Selection

Selected Term - Hernia

Choose from these Topical Subheading

El

Use these Topical Subheadings

ALL - Apply All Subheadings =
NONE - Term without subheadings ||
Cl - CHEMICALLY INDUCED
CL - CLASSIFICATION

CO - COMPLICATIONS

DH - DIET THERAPY

DI - DIAGNOSIS

K |

_>l_I

Choose from these Age Subheadings

ALL - Apply All Subheadings
NONE - Term without subheadings
1A - IN ADOLESCENCE |
1D - IN ADULTHOOD

>>Add>>

>>Add>>

11 - IN INFANCY AND CHILDHOOD ;I

Description

<<Remove<<

<<Remove All<<

<<Remove<<

<<Remove All<<

il

Use these Age Subheadings

(=]
=~

| | Cancel | |

Help

FIGURE 4-19 Subheadings Selection dialog box
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2. Click on a subheading in the Choose from these Subheadings list.

3. Ifdesired, click Description to view a short description of the

subheading.

4. Click >>Add>> to add the subheading to the Use these Subheadings

list.

5. Repeat steps 2 through 4 to apply additional subheadings to your

term.

6. Click OK. WinSPIRS searches for the term and any subheadings, or
adds the search to the Selected Term List.

WinSPIRS keeps track of the thesaurus terms you view in the Thesaurus

History.

To view the Thesaurus History:

*  Select Show Thesaurus History from the Options menu.
WinSPIRS displays the Thesaurus History dialog box. It displays
thesaurus terms you have viewed and indicates the screen in which
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Resetting the
Thesaurus

each was viewed

Thesaurus History

[Fernia, Diaphragmatic [ Permuted List ] -
Hernia [ Term Information ]
Hernia [ Full Tree ]

Hernia [ Term Information ]
Hernia [ Permuted List ]
Kidney [ Term Information ]
Kidney [ Full Tree ]

Kidney [ Term Information ] ;l

| OK I|Cance||| Help I

FIGURE 4-20 Thesaurus History

To return to the display of a term:

Click on a term in the Thesaurus History.

Click OK. WinSPIRS returns to the screen in which you had viewed

the term.

At any point, you can clear the Selected Term List and Thesaurus
History, and return to a blank Permuted Index screen.

To reset the Thesaurus:

Choose Reset Thesaurus from the Options menu at the Permuted
Index, Term Information, or Full Tree View screen. WinSPIRS

confirms that you want to reset the Thesaurus.

Click Yes.
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Using the Table of Contents

Selecting a Table of
Contents

Looking Up a Full Text
Record

Databases that provide the full text of documents are organized
hierarchically. These full text databases include a Table of Contents,
which is similar to that in a book: it provides an outline of the database,
which may be organized by subject, publication, chronology, or other
means.

The Table of Contents is not available for bibliographic databases that do
not have full text.

If you display the Table of Contents with multiple full text databases
loaded, WinSPIRS displays the Available TOCs dialog box, and you
must choose the database you want to search.

Available TOCs [x]
ish 1o vi
Select the Table of Contents you wish to view S
Health-CD_Acts_of Parl 04/37
Health-CD_Collection 04797
Health-CD_Statutory_Inst 04/97

FIGURE 4-21 Available TOCs dialog box
To select a table of contents:
1. Click on the database whose contents you want to view.
2. Click OK.
Once in the Table of Contents, you can change to the table of contents of

another database. To do so, click Change TOC... or select Change Table
of Contents... from the Options menu.

To look up a record in the Table of Contents:

1. Click Contents on the button bar. WinSPIRS displays the Table of
Contents.

2. Click the plus icon: & to the left of a topic of interest. WinSPIRS
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displays the topic’s subtopics.

' WinSPIRS 4.0 - 0SH-CD [_ O] =]
File Edit Utilities PRecords Mark Options  “iews Help

|J@- Database I |é Print I |E Download I |$ Searches I | Index I | Contents | |Thesaurus I

Table of Contents I GUIDAMCE AND AD. : Advsory and Joint Standing C... - ASBEE
UK LEGISLATION B Expand
EINTERFRETATIONS OF THE LEGISLATION _I )
=GUIDANCE AND ADVICE Contract |
= Advisory and Joint Standing Committee Reports ‘:
=ASBESTOS, Advisory Committee on CamiE J

SIASBESTOS - FINAL REPORT, vOL. 2

o]

EEI Bibliographical Reference
THF Il | .FFFFrTS NF ASRFSTAS AK HEALTH { F N Achasan and b .| r:mlnm_lL|

FIGURE 4-22 Expanded topics in the Table of Contents
3. Scroll through the subtopics and expand one of interest.

4. Continue expanding topics until you reach a level of topics that have
book: [d and page: E] icons to their left. These icons represent
records and sections of records, which you can display, as described
below.

Showing Full Text To show a record in the Table of Contents:
Records

1. Click on any topic with a book: [ or page: E] icon to its left.

2. Click Show. WinSPIRS displays the text of the highlighted topic

| OSH-CD - ASBESTOS -

Preface 2

¥ 1his volume contains papers commissioned by the Advisory Committes and used
in preparing their final report.
a THE ILL EFFECTS OF ASEESTOS UPON HEALTH by E D Acheson and M J Gardner is
the full report from which the agreed sumary at Chapter 3 in Volume 1 is =
drawn., Material frowm ASBESTOS CONTROL LIMITS by J Steel is incorporated
more fullv into the main text but is warticularlv relevant to Chanters 3

\ Next Hil” Previous Hill \ Brief Fields ” Add to Search ” Change TOC... | | |

FIGURE 4-23 Portion of a full-text record

3. Scroll through the text. Note that you can scroll to other topics in the
Table of Contents.
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4. Ifnecessary, click Synchronize to scroll to and highlight the
heading in the Table of Contents that corresponds to the currently
displayed text.

You can mark, print, and download portions of the full text records. See
“Marking and Unmarking Records” on page 517, “Printing Records”
on page 5-19, and “Downloading Records” on page 5-22 for more
information.

The Table of Contents screen has been modified to accommodate SGML
databases. For non-SGML databases, the only change is that you now
need to select one table of contents if you are searching multiple full-text
databases.

Browsing an SGML Browsing SGML databases is slightly different:

Table of Contents
1. Ifnecessary, click Go to Top to reset the Table of Contents so that
all the broadest-level headings are displayed.

Table of Contents

= Health-CD: Collection - Table of Contents Il GotoTop
= Circulars A packup
* Department of Health Publications
= Journals

* Parliamentary Papers
= Press Releases
= Social Services Inspectorate

Cudictioal Duaalioal]

FIGURE 4-24 Top level of an SGML Table of Contents
2. Expand a topic of interest:

« Ifatopic is preceded by a bullet = click the topic to display its
subtopics.

» Ifatopic is preceded by a plus & or minus = icon, click the
icon to show (plus) or hide (minus) the subtopics.

3. Continue expanding topics until you reach headings that are
highlighted in blue. This highlighting indicates record titles and
section headings
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Table of Contents

= Health-CD: Collection - Table of Contents : Dept of Health ~| GotoTop |
Publications Back Up
= Department of Health - Publications i

@ ABC of health promotion in the workplace : a resaurce pack for employers
= ABC of mental health in the workplace © a resource pack for employers

« WHY DO INEED TO KNOW ABOUT MENTAL HEALTH?
= WHAT IS A MENTAL HEALTH PROBLEM?
= HOWY CAN IRECOGMISE MENTAL HEALTH PROBLEMS?
n WHAT.CALSES MENTAL HE AL THPRORI EM hd I

FIGURE 4-25 Record and section titles in an SGML Table of Contents

4. Click on a highlighted record or section title to display the text.
WinSPIRS indicates progress as it loads the record, and then
displays the record.

| Heatth.CD; Colleciion DA ABC of merial health o
C HOW CAN | RECOGNISE MENTAL _|
HEALTH PROBLEMS?
Being aware of how we and those around us are feeling and behaving is the best
way.
[ Next Hit | [ Previous Hit | | Briet Fields || Add ta Search || change ToC .| [EN

FIGURE 4-26 Portion of an SGML record

5. Scroll through the text. Note that you can scroll to other sections of
the record.

If necessary, click Synchronize to display the portion of the Table of
Contents that corresponds to the currently displayed text

Using the Search History

The Search History area of the Search screen provides a numbered list of
all your search requests and indicates the number of records retrieved by
each. The Search History is updated with each search request.

You can reuse or clear any search from the Search History. You can also
save your history and rerun a previously saved history.
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You can reuse any search request in the Search History to combine it
with a new search or to show, print, or save the records retrieved by it.

To combine a previous search with a new one:

1.

Click on the desired search request in the Search History area and
click Retype. The search statement is automatically placed in the
Search: prompt.

Alternatively, you can type the number of the desired search request
in the Search: prompt.

Combine the search with additional terms using the available
operators. For example, you could construct a search request, # 1
and freud in au.

Click Search. The Search History reports the number of records
retrieved by the search request and the records are displayed in the
Retrieved Records area.

To show, print, or save the results of a previous search:

1.

Double-click on the desired search in the Search History window.
WinSPIRS performs the search on the currently selected
database(s). The records from the search are displayed.

Select Print Records or Save Records from the File menu.
See “Showing Records” on page 5—1, “Printing Records” on page 5—

19, and “Downloading Records” on page 5-22 for more informa-
tion.

During a search session you can clear searches from the Search History
area. For example, before you save a search history you can eliminate the
unwanted search statements for clarity.

1.

Click the Clear... button in the Search History area or choose Clear
Search History from the Edit menu. WinSPIRS displays the Clear
Search History dialog box.

Indicate the searches you want to clear:
*  Click All to clear the entire search.

*  Click Searches to enter the numbers of the searches to clear.
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Use commas to separate individual search statements and
hyphens to identify a range of search statements. For example,
to clear search statements 2 and 3 and search statements 7
through 10, type 2, 3, 7-10.

3. Click OK. WinSPIRS renumbers the remaining searches, if

necessary.

Saving a Search
History

WinSPIRS allows you to save your search requests and run them during
future work sessions. This is especially useful for complex searches or
those you perform on a regular basis.

Note: You may want to clear unwanted searches before saving, as
described in the previous section.

To save your search history:

1. Choose Save Search History... from the File menu. WinSPIRS
displays the Save Search History dialog box.
Save Search History
File Name: Directories: “
m d:\winspirs _
T A
B WINSPIRS
=]
CIDBASE
5 LANGUAGE
£1 SHARED
2 E1TMP T
List Files of Type: Drives:
|Histary Files(~ his) z] J=d vamaw =]
Description: ICINAHL (R) 1982-4/96
FIGURE 4-27 Saving a search history
2. Select the appropriate drive and directory from the lists provided.
3. The default name of your search history file is search.his. You can
type a new name File Name text entry area.
4.

Enter a brief description, up to 45 characters long. The description
will be available when you run the history.

5. Click OK to save the search history.
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Running a Saved To run a previously saved search history:
Search History
1. Choose Load and Run Searches... from the File menu. WinSPIRS
displays the Run Search History dialog box.

Run Search History [x]
File Name: Directories:
d:\winspirs

o A
= WINSPIRS
SEae
£ DBASE
1 ENTITYRC
Shiived
£ SHARED
d | Ene -
List Files of Type: Drives:
History Files(*.his) jJ I d: Yamato J

FIGURE 4-28 Running a saved search history
2. Select the appropriate drive and directory form the lists provided.
3. Select a search history from the list of search history files.

4. If desired, click Description for a description of the selected search
history.

5. Click OKto run the search history. WinSPIRS performs the searches

and displays the results in the Search History area of the Search
screen.

Note: If the search history is from a different database than the one
you are currently using you can still run the search. However, if
fields are searched in the search history that do not exist in the cur-
rent database, those search statements are identified with n/ a in the
results column; in other words, the results are not available.

Using Current Awareness Searches: SDIs and Alerts

Your WinSPIRS administrator may have set up WinSPIRS in your
organization so that you can use “current awareness searches”. These are
searches that the system runs automatically, at regular intervals, and then
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SDI and Alert Menu
Items

Creating an SDI from
WinSPIRS

emails the results to you. There are two types of current awareness
searches: SDIs, and Alerts.

With SDIs, (Selective Dissemination of Information) you create and
save your own searches and the system runs them automatically. You
specify the interval at which you want the search to be rerun and give
your email address so that search results are mailed to you. You create an
SDI search in WinSPIRS, then, when you choose the Create SDI... menu
item, WinSPIRS automatically establishes a link to WebSPIRS, where
you set up the SDI.

With Alerts, authorized users can subscribe to a selection of searches
created by your WinSPIRS administrator or librarian. These searches are
run periodically, and the results emailed to users who have subscribed to
the Alert service.

Ask your WinSPIRS administrator if you are not sure whether you have
access to SDIs or Alerts.

If you have been authorized to use SDIs and Alerts, your WinSPIRS 4.0
screen contains new File menu items that function with the SDI feature.

Use this File Menu Item To do this

Create SDI... Set up an SDI. After conducting a
search and choosing this menu item,
WInSPIRS 4 links automatically to
WebSPIRS and displays the Create
SDI screen.

Show SDI Account... Edit or administer existing SDIs by
linking to WebSPIRS 4 to view an
account you setup previously.

Alert Service... View and subscribe to alerts by linking
to WebSPIRS 4.1.

To create an SDI:

Note: The databases you select for a WinSPIRS search must also be
available on the WebSPIRS server that runs the SDIs. Ask your
WinSPIRS administrator if you are unsure about this.

1. Carry out one or more searches in WinSPIRS.
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2. Revise your search until it meets your needs for an SDI.
3. Save the search that you want to use for the SDI. See “Saving a
Search History” on page 4-29.
4. Choose Create SDI... from the File menu. This launches a browser
connection to WebSPIRS 4x.
5. Follow the WebSPIRS online help for creating the SDI.
Subscribing to an Your WinSPIRS administrator may have set up some Alerts. These are
Alert pre-configured searches, similar to SDIs, that you can subscribe to and

have the search results emailed to you automatically by the system.

To subscribe to an alert:

1.

Choose Alert Service. from the File menu. This opens a browser,
and connects to WebSPIRS.

In the WebSPIRS Alerts screen, choose any Alerts you want to
subscribe to, and enter your email address.

See the WebSPIRS online help for more information about subscrib-
ing to Alerts.

Searching Multiple Databases

With WinSPIRS, you can search more than one database at a time. When
doing so, you must keep the following in mind:

The databases may not have all fields in common; if you search in a
specific field (either in the Search screen or the Index), you will only
retrieve records from those databases that contain the field.

The Thesaurus is unavailable, even if each of the selected databases
has a Thesaurus.

The Suggestions feature is unavailable.

Each database has its own set of Guides in the Help menu.
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See “Selecting a Database” on page 3—2 for instructions on selecting
multiple databases.

Narrowing and Broadening Your Search

If your initial search request retrieves too many or too few records, you
can narrow or broaden the search using the following techniques. These
are discussed further in previous sections of this chapter.

To narrow your search:

“Searching in Specific Fields” on page 4-9
“Searching in Limit Fields” on page 4-10
“Combining Terms with Operators” on page 4—6

Select more specific terms by “Using the Index” on page 4-14 and
“Using the Thesaurus” on page 4—17.

To broaden your search:

“Using Truncation and Wildcards” on page 44, to retrieve
variations of your search terms.

“Combining Terms with Operators” on page 4—6

Select broader terms by “Using the Index” on page 4-14 and “Using
the Thesaurus™ on page 4—17.

“Searching Multiple Databases” on page 4-33)
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Showing Records

Changing Show
Options
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Using Retrieved Records

Once you have searched for and retrieved records of interest, you have
several options, including displaying, printing, and downloading records,
and marking a subset of records. You can also output records in a variety
of formats by changing the Show, Print, and Download options.

You can show the records retrieved by any of your searches.
To show records:

1. Inthe Search History area, click on the search you want to show; the
search is highlighted.

2. Click the Show button to display records for the selected search.

Records are displayed automatically after each search if you select
Automatic Records Display from the Options menu. You can turn this
option off for faster searching, and then show retrieved records as
described above.

You can determine how records are displayed by changing the Retrieved
Records Options. These options include which fields are displayed, how
field labels are displayed, and whether graphics are displayed within
records.

To change show options:

1. Choose Show Options... from the Options menu. WinSPIRS
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displays the Retrieved Records Options dialog box.

Retrieved Records Options

Choose from these Fields/Fieldsets

ALL
HITS - Fields with search terms
Default (TLAU,S0,SLAN,ON)

TI-TITLE

AU - AUTHOR(S)

A - AUTHOR AFFILISTION
Ci - CORPORATE AUTHOR(S)
AD - PRODUCER ADDRESS

M

CITN - CITATION (TLAU S0, SLAN QM)

20 -S0URCE (BIELIOGRAPHIC CITATION)
»

|v

>>Add>>

<<Remove<<

<<Remove All<<

Field Labels
@® Short Field Names
C Long Field Names
O No Field Names

Display these Fields

TI-TITLE

A~ ALUTHOR(S)

S0-S0URCE (BIBLIOGRAPHIC CITATION)
Sl-SERIALIDENTIFER

AN - ACCESSION NUMBER

O - UMI ORDER NUMBER

Other Options
™ Auto Full Screen
X Indent Text
X Show Graphics

0K, I ‘ Cancsl

| ‘ Font.__ || Fixed Font

|| Default Settings H Help |

FIGURE 5-1 The Retrieved Records Options dialog box

2. Add the fields you want to show to the Display these Fields list.

Note: If the Make Default Fields button is available, you can make
the selected set of fields the default for the current database. You
will be asked to restart WinSPIRS; the new default will be effective
every time you search the current database.

3. Indicate how you want fields to display in the Field Labels area:

*  Short Field Names displays field abbreviations, such as “TI”.

* Long Field Names displays the full field names, such as

“Title”.

* No Field Names omits field names from retrieved records.

4. Choose from the Other Options:

e Auto Full Screen shows a full-screen view of the retrieved
records each time you click All Fields.

* Indent Text indents the text of retrieved records under the field

labels.

*  Show Graphics displays graphics within the text of retrieved
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records.

Note: WinSPIRS always displays links to the graphics; Show
Graphics determines whether graphics are displayed inline in addi-
tion to the links.

5. Ifdesired, change the style of text in retrieved records:
*  Click Font to set the font and size of text.

*  Click Fixed Font to select from a list of monospaced fonts, in
which all characters are the same width. These fonts are useful
for aligning columns and tables in records.

6. Click OK to close the Retrieved Records Options dialog box.

You can sort up to 1000 retrieved records by a field that you choose. For
example, you can sort records alphabetically by author, or
chronologically by publication date. You can then show, print, or
download the records in sorted order.

To sort records:

1. Choose Sort Records from the Records menu. WinSPIRS displays
the Sort Records dialog box.

Sort Records [x]

Field to sort on:

Sorting
C Mone AL - AUTHOR(S)
. AA-AUTHOR AFFILIATION
@ 9 CA- CORPORATE AUTHOR(S)
C Descanding AD - PRODUCER ADDRESS
50 - SO0URCE (BIBLIOGRAPHIC CITATIO

SE-SERIES TITLE
l}\ S\I- SERIAL IDENTIFIER | il
4

| (0] 4 I| Cancel I | Help I

FIGURE 5-2 Sorting records chronologically by publication date

2. Choose Ascending or Descending as the method of sorting.
3. Click on the field to sort by.

4. Click OK. WinSPIRS displays a progress message as it sorts the

records.
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Note: Sorting is deactivated automatically when you perform another
search or display records from another search in your search history.

Using Full Text Records

Showing Full Text
Records

I WinSPIRS 4.0 M= B3

If you are searching full text database, the Retrieved Records areas of the
Search and Index screens (but not the TOC screen) display only
bibliographic portions of full text records: the full text is displayed in a
separate window.

To show the full text of a record:

1. Perform a search in the Search area screen or choose a term or phrase
from the Index screen.

2. Scroll through the retrieved records. WinSPIRS enables the Show
Full Text button if the current record contains full text.

Eile Edit Utilities Becords Mark Options Yiews Help
|@-Dﬂtabﬂse ”%Prinl ”EDuwnluﬁd I |%Seamhgg ||Index ”Cumenls ”Thesﬂurus I

Search]

No. Records Search Search HiSlOfy
#1 10 hiatus ol Show
# 37 hernia — 4
i3 7 hiatus hernia Limit._.

Acts TOC April 1997
1 of 7 in search #3

m TI: Directory of sthnic¢ minority initiatives
(o730 Department of Health;
EU: London: Department of Health, May 1996. 9Z-pages
M Learning Disabilities
Chg Department of Health;
EU: Leeds: Department of Health, February 1594, Zé-pages
SE: [Patient Perception Booklets
M General articles : Gastro-ossophageal reflux disease
(o730 Department of Health; Department of Medicine, Queen Alexandra
Ho=nitsl. -
| Next Hit | [ revious Hit | | AnlFields || Show Full Text || Add o Search | [EN

FIGURE 5-3 Search screen, displaying bibliographic portions of full text
records

3. Click Show Full Text. WinSPIRS displays the new Full Text
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window and, if appropriate, shows display progress as it loads the
full text of the current record. Only the current record is displayed in
the full text window, so the scrollbar is more sensitive and
navigation within the record is improved.

To display the full text of a different record just click into the biblio-
graphic section of that record (on the main search or index screen)
and then click Show Full Text again. In this way the main and Full
Text windows can be used as a 'coarse' and 'fine' control for navigat-
ing between and within records.

4. Click Show Full Text. WinSPIRS displays the Full Text window
and indicates its progress as it loads the full text of the current

record.

B Full Text
File Edit Becords

Mark  Options

H[=] E3
Help

Health-CD_Collection 04/97 : General articles : Gastro-oesophageal reflux disease

3 of 7 in search #3 (marked)

= General articles
Gastro-oesophageal reflux
disease
= |ntroduction
= Symptoms
= |nvestigation
= Management
= Changes in lifestyle
@ Drugs inthe
management of reflux
disease
= Choosing treatment
= Surgery
= Conclusion
= Further reading

Management

Changes in lifestyle

Patients with mild reflux disease can be greatly helped

by modest adjustments of lifestyle. Thus, the loss of a _|
few kilograms in weight can often completely alleviate
symptoms. Avoidance of straining or stooping,

especially after a large meal, is often helpful. Meals late

at night are best avoided, as are spirits taken neat.

Elevation of the head of the bed has been shown to help.

If drug treatment appears to be aggravating symptoms, it

should be reconsidered.

Drugs in the management of reflux
disease

‘ MNext Hit || Previous Hit || Add to Search || Contents I| Full Text Search |

Close

FIGURE 5-4 Full Text window with record outline, for an SGML database

The Full Text window displays the full text and, optionally, an out-
line of the record.

Browse the record using the scroll bar and Next Hit and Previous Hit
buttons.You can also use the record outline, described in the next
section.
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Displaying Records The record outline in the Full Text window is virtually the same as the

using the Outline Table of Contents, but it applies only to the current record. You can show
any section of the record, and you can expand and contract headings and
subheadings.

The record outline functions differently for SGML and non-SGML
databases.

Note: By default, WinSPIRS displays the record outline. To hide the
outline and expand the record display area, select Hide Record Outline
from the Options menu.

For SGML Databases

FIGURE 5-4 shows the record outline as it appears in SGML databases

To do this: Do this: The result is:

Show a section of the record Click on a heading. =  WInSPIRS highlights the
heading with a yellow arrow
and displays the
corresponding section of the
record.

Expand and contract & Click on any heading

headings = preceded by a plus or minus

to show or hide its
subheadings.

Browse a record Use the scroll bar, or Next =z WInSPIRS adjusts the
Hit and Previous Hit. position of the yellow arrow in
the record outline as you scroll
through the record.

See “Using the Table of Contents” on page 4-25 for more information on
navigating SGML records.
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For Non-SGML Databases with Full Text
The record outline as it appears in non-SGML databases is slightly
different.
B Full Text = ES
File Edit Becords Mark Options Help
0SH-CD : 93/ 103/EEC. CONCERNIMNG THE MIMIMUKM 5. : THE COUNCIL OF THE EUROPEAN UNION,
1 of 156 in search #3
0] =93 103/EEC. CONCERNING THE - THE COUNCIL OF THE ﬂ
El
EUROPEAN UNION,
"= Adticle 1 Object Having regard to the Treaty establishing the
= Aticle 2 Definitions Buropean Community, and in particular Article
= Article 3 General provisions 112a thereof,
3 Article 4 New fishing vessels Having regard to the proposal from the
|5 Article 5 Existing fishing vess Commission, {OJ Ho © 337, 31. 12. 1991, p.
L5 Article 6 Extensive repairs, cc 21; OF Mo © 311, 27. 11. 1992, p. 21.} drawn
L= Article 7 Equinment and main up after consultation with the aAdvisory
n quip N Committee on Safety, Hygiene and Health
—EIAn!cIeBInfn.m.ﬂatmn far worke Frotection at Work,
_EAH!EIEQTHINW of workers In cooperation with the European Parliament,
= Article 10 Detailed training of {0J No ¢ 241, 21. 9. 1992, p. 106; and
= Article 11 Consultation and pz Dezision of 27 October 1993 (not yet
= Article 12 Adaptation of the A published in the ©Offieial Journal).}
-3 Article 13 Final provisions Having regard to the opinion of the Economic
L= Article 14 and Social Committese, {0OJ No © 169, &. 7.
HEIANNEX | MIMIMUM SAFETY Al 1992, p. 48.3
LEIAMNEX || MINIMUM SAFETY A, Whereas, in its resolution of 21 December
— _';I 1987 on safety, hygiene and health at work, {
C ST WA vt 2A. A 2 198A. m. 1.} the Cooncil 5
‘ Next Hit || Previous Hit || Add to Search || Contents I| Full Text Search |

FIGURE 5-5 Full Text window with record outline, for non-SGML

database

To do this: Do this: The result is:

Show a section of the record Double-click on a heading. WIinSPIRS highlights the heading
and displays the corresponding
section of the record.

Expand and contract Click on any heading

headings - preceded by a plus or minus

to show or hide its
subheadings.

Searching from Retrieved Records

You may see a word or phrase in a retrieved record that suggests an
alternative search strategy. You can select the terms for searching and
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Lateral Searching

WinSPIRS automatically places them in the Search: text entry box. This
process is often referred to as “lateral searching.”

To make a lateral search:

1.

Browse through the retrieved records. When you identify a term in
one of the records that suggests another search, highlight the term by
double-clicking or dragging across the term.

Note: Some words and symbols that might occur within records
have a special meaning in WinSPIRS, (for example; operators such
as AND and OR, stop words, such as “the”, and hyphens or { and })
Do not include such items in the text you highlight for lateral search-
ing.

Click Add to Search.

WinSPIRS adds the selected text to the Search: text entry box, fol-

lowed by the short name of the field from which the text was select-
ed. If there is text already in the Search: box, WinSPIRS adds the or
operator before adding the new text.

1 WinSPIRS 4.0 - CINAHL (O] ]
File Edit Utilites Becords Mark Options Yiews Help

|@ Database | ‘%Prinl I|ﬂ Download I |$ Searches H Index | ‘Cnnlents ”Thesaurug I

3.

Search: |hern\a; "refl in TI Suggesll

FIGURE 5-6 A term selected from the Title (Tl) field

Click Search.

Displaying Hotlinked Records

In some SilverPlatter databases, records are linked to other relevant
records. The links between these records, called “hotlinks,” appear as a
different color or shade of text within records.

Look at the database Guide in the Help menu to see if the database you
are searching has hotlinks.

To show a hotlinked record:
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1. Scroll through the retrieved records until you find a hotlink. Note
that when you pass the mouse over the hotlink the cursor changes
from an I-beam to a hand, as shown in the following figure:.

PsycLIT Chapters & Books
1 0f 3938 in search #1

[ Ew: 1937

IZ: 0-393-04053-4 ithardcover) :
[M] AN: CHAPTER 97-08Z045-0188EE PREVIOUI CHAPTER 2EE MEXT CHAPTER
TI: Promoting mental health during the transition into adolescence.
AU: Petersen, -Anne-C.; Leffert, -Nancy; Graham, -Barbara; Alwin, -Jan; et-al
IN: National Science Foundation, aArlington, VA, U3
ER: Health risks and developmental transitions during adolescence. (John
gchulenberg, Jennifer L. Maggs, Klaus Hurrelmann, Eds.), pp. 471-497.
Cambridge University Press, New York, NY, US; xviii, 580 pp.3EE BOOK -
BY: 1987
| Next Hit | [ revious Hit | | AnlFields || Show Full Text || Add to Search | |

FIGURE 5-7 Retrieved record with hotlinks

2. Click on the hotlink. WinSPIRS displays the linked record in the
Hotlink window:

File Edit Becords Mark Options Help

PsycLIT Chapters & Books
Linked Record #1

EDITED-BOOK 27-02Z045-000

Health risks and developmental transitions during adolescence.

gchulenberg, -John (Bd); Maggs, -Jennifer-L. (Bd); Hurrelmann,-Klaus (Ed}

U Michigan, Tnst for Social Research, &nn Arbor, MT, US

cambridge University Press; New York, NY, US; xviii, 580 pp.

1987

0-521-48053-1 (hardcover)

English

20 chapters selected from 20

AT: MZ2; Interdisciplinary: Graduate/Professional

uD: 9709

DE: ADOLESCENT-DEVELOPMENT; MENTAL-HEALTH; HEALTH-; AT-RISK-POPULATIONS;
DEVELOPMENTAL-3TAGES; ADOLESCENTS-; YOUNG-ADULTS

cc: 2800; 3360; 28; 33

FPO: Human

AG: Adolescent; Adult

CR: (from the jacket) In (this book), prominent researchers in the

adolescent fisld sxamine how wvarious developmental transitions

associated with the passage from childhood to adulthood present risks

Ao

and opportunities for adolescents' mental and physical health. This
interdiseiplinary book offers the foundation for a unifying framework
for research and application in health and human development. This

in paychology, education, socioclogy, public health, social work,
adolescent medicine, and policy-making.

book will appeal to faculty, students, researchers, and practitioners —~

\ Next Hil” Previous Hill \ Brief Fields ” Show Full Text ” Add to Search | | Back | [Close!

FIGURE 5-8 Hotlink window

3. Click Close to close the window.
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Window from the Views menu.

You can also leave the window accessible by minimizing it or send-
ing it to the background; you can later display it by selecting Hotlink

Hotlinks in SGML The way hotlinks are shown varies from one SGML database to the next,
Databases but is generally as follows:
text Underlined words, numbers, etc. provide links to

relevant text.

Blue arrows pointing to the left generally provide
return cross-references, such as from a citation

to the text that referenced it.

(Some databases use an arrow pointing to the

right for cross-references.)

If the current text is referenced more than once,
WinSPIRS displays the Link Destination dialog
box when you click on the reference arrow.

Link Destination
Select Desired Link Destination

Text

Context

Table 1 Number of deaths aged 1119 by ICD ch
Table 1 Number of deaths aged 1119 by ICD ch
Table 1 Number of deaths aged 1119 by ICD ch
Table 1 Number of deaths aged 1119 by ICD ch
Table 1 Number of deaths aged 1119 by ICD ch

OK:

Cancel

Help

II ]

FIGURE 5-9 The Link Destination dialog, providing multiple contexts from

which the current text is referenced

To choose a link from the Link Destination dialog box:

1. Click on the text of the reference to which you want to link.
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2. Click OK. WinSPIRS displays the text in which the link occurs.

An information symbol is a link to footnote text.
@ When you click on one, WinSPIRS displays the
following Footnote window:

1] =] E3
L
Priority Setting in the NIIS:
The Drugs Budget, HC 80-1,
Bession 1993-94

FIGURE 5-10 The Footnote window

To return to the location of the footnote, click the blue return arrow.

SilverLinker Support

If your organization has set up support for the SilverLinker database, you
will see a new field, called FTXT (meaning full text), in some of the
displayed records.

This field contains direct links to full text articles, located at publisher
web sites. If you click on the link, your default web browser launches
automatically, and links to the site containing the article.

If you know that you have SilverLinker support but you do not see any
records with full text links, check that you have set your options for
displaying records to include the field FTXT. (See “Changing Show
Options” on page 5—1.) If you still do not see any full text links, ask your
WinSPIRS administrator which publisher sites you have access to: your
search may not be finding any records for articles at those sites.
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', WinSPIRS 4.0 - MEDLINE M= E
Eile Edit Utilities Becords Mark Options Yiews Help

|@- Database I |é Print I |E Download I |$ Searches | | Index I ‘Cumenls I |Thesﬁurus I

Seargh: | Search I Suggest I

No. Records Search Search HiSlOfy
#1 612 hernia ol Show

2 30 hiatus — 4
#3 512 hernia Limit._.
# 12 ‘

hiatus hemia

MEDLINE
4 0of 12 in search #4

fundoplication.
AUz Luostarinen-M; Rantalainen-M; Helve-0; Reinikainen-F; Isolauri-J
g0 Br-J-&urg. 1992 Feh; 853(Z2): Z7Z-5
FTXT: Full text from SwetsMNet (US Mirror) Full text from SwetsNet
I®3EN: 0007-1323 Eﬁ
La: ENGLISH
AN: SB1AZ2456
J vT: Massive histus hernia: evaluation and surgical management.
ATT: Maziak-DE; Todd-TR; Pearson-Fa
‘ MNext Hit || Previous Hit | ‘ All Fields || Show Full Text || Add to Search I &

FIGURE 5-11 Record displaying a SilverLinker link

Note: Earlier versions of WinSPIRS do not support the SilverLinker
feature. In WinSPIRS 2.1 and 2.2, the full text links display as hotlinks,
but clicking the link displays an error message.

Displaying Local Library Holdings Information

When you look at records retrieved by a search, you may also see details
of local library holdings: that is, information about whether your library
has a copy of the publication, and, if so, where it is stored. The exact

details you see depend on whether your WinSPIRS administrator has set
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this feature, and the amount of detail about location and availability that
they have decided to include.

"Dannenbring, -Dawn; Stevens,-Michasl-d.; House,-Alvin-E.

: ULIE Per R 726.5 J68¥ v.1+ 1978+

Journal-of-Behavioral-Medicine; 1997 Apr Vol Z0(Z) 127-14Z2

. Al
Information about
JH:

Sustained change in parents receiving preventive interventions for
families with depression.

Beardsles, -William-R.; Salt,-Patricia; Versage, Eve-M.; Gladstons,-
Tracy-R.-G.; et-al

American—-Journal-of-Psychiatry; 1997 Apr Wol 154(4) 510-515

ULIE Per - Current Display RC 321 &5Z2 w.105+ 1949+

local library i
holdings, using ﬁ;x:

the field *LHM AU

JH:

A

Marked improvement of tardive dystonia in a schizophrenic patient
after electroconvulsive therapy.

Yoshida, -Keizo; Hasehe,-Takami; Higuchi,-Hisashi; Shimizu, -Tetsuo
Human-Paychopharmacology-Clinical-and-Experimental; 1996 Sep-Oct Vol
11(5) 421-423

No holdings information for this record

TT:
ATT:
0

HM:

Trazodone therapy of the post-stroke depression.

Raffaele,-R.; Rampello,-L.; Vecchio,-T.; Tornali,-t.; est-al
Archives-of-Gerontology-and-Geriatrics; 1996 Suppl 5 217-220
DEWEY EXT Per RC 952 Al AT73X Mot currently received., vw.l-vw.16,ne.l
1982-Jan./Feh.15993.

TI:

Psychoactive drugs for pain control.

FIGURE 5-12 Examples of holdings information

You can only see holdings information if the fields *LHM and *LHC are
supported by the database, and if you select them to display in the
Retrieved Records Options dialog box. See “Changing Show Options”
on page 5—1.

To display only records that have local holdings details:

1. Perform a search.

2. Choose Show Options... from the Options menu.

3. Inthe Retrieved Records Options dialog box, select *LHM and *LHC
and add them to the list of displayed fields. Click OK.

4. Choose Show Held Titles Only from the Records menu.

Displaying Graphics

Some SilverPlatter databases include graphics, which are linked to the
retrieved records. The links appear as a different color or shade of text
within records, and usually say “see graphics”. You can display linked
graphics in a separate window or within the retrieved records.
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Refer to the database Guide in the Help menu to determine if the
database you are searching has graphics.

To display graphics in a separate window:

1. Perform a search. The database Guide may suggest how to search for
graphics.

2. Scroll through the retrieved records until you find a linked graphic.
Note that when you pass the mouse over the link the cursor changes
from an I-beam to a hand.

' WinSPIRS 4.0 - EINECS-Plus/ECICS 1998 (ENGLISH) [ (O]
File Edit Utilties Records Mark Options Yiews Help

|~@:Datﬂbﬂse I|%Prinl I|EDownluad I |$Seﬂmhes ||Index ”Cumenls I|Thesaurus I

Search: I Search I Suggest I

No. Records Search Search Hlstory

#4 symbaol® = Show

# c
7 ci

#3 db=ds Retype

# db=dds 1
#10 ((ci or c.i) in znf, naml) and ((db=ds) or (db=dds)) - Clear...

EINECS-Plus/ECICS 1998 (ENGLISH)
3 of 137 in search #5

MAML: salts of Z-naphthylamine x
oL: Carc. Cat. 1; R 45

Zn; R 2%

u; R 51-53

CATEGORIES OF DANGER: Carcinogenic Category 1; Harmful; Dangerous
for the Environment

ST T (see graphic) ; H (see graphpe)

ID: Toxie [T]; Dangerous for the Ebdirorment [N]

REK: R: 45-22-51/53
May cause cancer. [R 45]
Harmful if swallowed. [R 22] -
Toxic to aquatic organisms, may cause long-term adverse effects in
+he acnatic ensironment re 51/5%1

| Next Hit | [ revious Hit | [ Briet Fielg_s” Show Full Text || Add to Search | [EN

FIGURE 5-13 Retrieved record with linked graphic
3. Click on the link.

WinSPIRS displays the linked graphic in the Graphic window.
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LN [CTE[=]
File Edit Yiew Help

Zoom In
Zoom Qut

Dangerous for the ervironment ([EN) j

FIGURE 5-14 Graphic window

4. Click Zoom In and Zoom Out, and select Fit to Window from the
View menu to resize the graphic.

5. Click Close to close the window.
You can also leave the window accessible by minimizing it or send-
ing it to the background; you can later display it by selecting Graph-
ic Window from the Views menu of the Search, Index, Table of
Contents, or Thesaurus screen.

To display graphics within records:

1. Perform asearch. The database Guide may suggest how to search for
graphics.

2. Select Show Options... from the Options menu. WinSPIRS
displays the Retrieved Records Options dialog box.

3. Select Show Graphics in the Other Options box.

4. Click OK. Graphics are displayed in the records, as shown below.
Note that links to the graphics are included, allowing you display the
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graphics in a separate window.

' WinSPIRS 4.0 - EINECS-Plus/ECICS 1998 (ENGLISH) H[=] E3
Eile Edit Utilities Becords Mark Options Yiews Help

|@- Database I |é Print I |E Download I |$ Searches | | Index I ‘Cumenls I |Thesﬁurus I
Search:|
No. Records Search Search HiSlOfy

# Symbal™ = Show
i chemic* —. l
#o B13 ci Limit._.
# 613 ci 1
# 2247 db=ds Retype
#5 127 db=dds 1
#10 25 ({ci or c.i} in znf, naml) and ({db=ds) or {db=dds]) - Clear... |

EINECS-Plus/ECICS 1998 (ENGLISH)
3 af 137 in gearch #

N _(see graphic
ID: Toxic [T]; Dangerous for the Enviromment [HM]
REK: R: 45-22-51/53

‘ MNext Hit || é’reviuus Hit | ‘ Brief rF“ieIgs‘” Show Full Text || Add to Search I =

FIGURE 5-15 Graphics within retrieved record
Printing and Downloading Graphics
You can print graphics from the Graphic window or embedded in
retrieved records. You can download graphics only from the Graphic
window.

To print or download from the Graphic window:

»  Select Print Graphic or Download Graphic from the File menu at
the Graphic window.

To print graphics embedded in records:
*  Check Print Graphics in the Print Records Options dialog box.
Graphics are printed within the text of records each time you print

records.

See “Changing Print Options” on page 5-20 and “Changing Download
Options” on page 5-23 for more information.
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Marking and Unmarking Records

With WinSPIRS, you can easily mark the records in which you are
interested, and later show, print, or download only those records. At any
point, you can unmark records in which you are no longer interested.

You can mark records in the Search, Index, Table of Contents, and
Hotlink screens

Records that provide the full text of documents are usually divided into
sections and paragraphs that you can mark individually. Collectively, the
reference fields of a full text record are treated as a section, except they
do not have a page icon.

Marking Non-SGML The following table shows how to mark records for non-SGML records.
Records
To do this: Do this:
To mark a record Method 1:
& Click the book icon to the left of the record you want to mark.
Method 2:

To mark a section of a record

To mark a paragraph of a
record

1. Put the cursor in the record.
2. Select Mark Record from the Mark menu.

WinSPIRS highlights the record.

Method 1:
Click the page icon to the left of the section that you want to
mark; WinSPIRS highlights the text.

Method 2:
1. Put the cursor in the section.
2. Select Mark Section from the Mark menu.

Method 1:
Click the torn page icon to the left of any paragraph you want
to mark.

Method 2:
1. Put the cursor in the paragraph.
2. Select Mark Paragraph from the Mark menu.

(Sheet 1 of 2)
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To do this:

Do this:

To mark the reference fields

To unmark a record, section,
or paragraph:

To unmark all marked text

1. Put the cursor in any of the reference fields.
2. Select Mark Reference Fields from the Mark menu.

Method 1:
Click the book, page, or torn page icon to the left of the record
or portion of record that you want to unmark.

Method 2:

Select Unmark Record, Unmark Section, Unmark
Paragraph, or Unmark Reference Fields from the Mark
menu.

Select Unmark All from the Mark menu.

(Sheet 2 of 2)
Marking SGML Marking SGML records is slightly different. With these records, you can
Records mark the bibliographic portions or the complete records, but you cannot

mark selected portions of SGML full text.

To do this:

Do this:

To mark bibliographic fields

To mark a complete record:

Select Mark Reference Fields from the Mark menu of the
Search or Index screen.

Method 1:
Click the book icon to the left of the record in the Search or
Index screen.

Method 2:
Select Mark Record from the Mark menu of the Search,
Index, or Table of Contents screen or Full Text window.
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With WinSPIRS, you can print the records retrieved by any of your
searches. You can also determine which fields are printed and whether
graphics and the search history are included.

To print records:

1. Click Print on the button bar, or select Print Records from the File
menu in the Search, Index, Table of Contents, or Hotlink screen.
WinSPIRS displays the Print Records dialog box, as shown below

Print Records

Printer:  Acrobat PDFPWriter on LPT1:

IIE

Print
Print Fields
@® As Shown l% Cancel
O Default

O User Selected
O Marked and Default

Options...

Print Range
O Marked Records
@ All Displayed Records
O Current Record [#1]

O Records:

Enter record numbers and/or record ranges
separated by commas. For example: 1.4.6-10

FIGURE 5-16 Print Records dialog box

2. Indicate the records you want to print in the Print Range area:

* Marked Records prints all records that are partially or fully
marked.

+ All Displayed Records prints all records displayed from the
current search.

*  Current Record prints the current retrieved record.

* Records lets you specify individual records to print. Separate
record numbers with commas, and use a hyphen to indicate a
range, suchas 1, 4, 6-10.

3. Indicate which fields you want to print:

*  As Shown prints the currently displayed fields.
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Printing SGML
Records

Changing Print
Options

*  Default prints the default fields for the database(s) you are
searching.

»  User Selected prints the fields selected in the Print Records
Options (click Options... to view or change the selected fields).

*  Marked and Default prints the default set of ficlds and any
additional text that you have marked.

4. If desired, click Setup... to change the printer configuration.

5. Click Print to begin printing.

Printing SGML records is similar to printing non-SGML records, with
these exceptions:

» Ifthe records you print include SGML and non-SGML records,
WinSPIRS prints all the non-SGML records, followed by the SGML
records.

*  WinSPIRS does not limit the number of SGML records you can
print.

You can determine how records are printed by changing the Print
Records Options. These options include which fields are printed, how
field labels are printed, and whether graphics and the Search History are
printed.

To change print options:

1. Choose Print Options... from the Options menu or click Options...
in the Print Records dialog box. WinSPIRS displays the Print



Printing Records 5-21

Records Options dialog box.

TI-TITLE AN - ACCESSION NUMBER.

AU - AUTHOR(S) <<Remove All<< | |0 - UM ORDER NUMBER.

A4 - AUTHOR AFFILIATION

CA - CORPORATE AUTHOR(S)

4D - PRODUCER 4DDRESS

SO*SOURCE(E\BLIOGRAPHICC\TATIONJ—'LI
»

Print Records Options
Choose from these Fields/Fieldsets Print these Fields
HITS - Fields with search terms — ALl-AUTHOR(S)
Drfault (T1ALLS0,SLAN M) — S0 - SOURCE (BIBLIOGRAPHIC CITATION)
CITIN - CITATION (TLAUSO.SLAN.ON) — SI- SERIALIDENTIFIER

O |
Field Labels———— Other Options
@® Short Field Names X Print Search History " Print Graphics
C! Long Field Names X Indent Text
' No Field Names [ One Record Per Page
OK I ‘ Cancel | | Font.__ | | Fixed Font. . | | Default Settings | | Help

FIGURE 5-17 The Print Records Options dialog box
2. Add the fields you want to print to the Print these Fields list.

Note: If the Make Default Fields button is available, you can make
the selected set of fields the print default for the current database.
You will be asked to restart WinSPIRS; the new default will be ef-
fective every time you search the current database.

3. Indicate how you want fields to print in the Field Labels area:
*  Short Field Names prints field abbreviations, such as “TI”.
* Long Field Names prints full field names, such as “Title”.

* No Field Names omits field names from printed records.

4. Choose from the Other Options:

*  Check Print Search History to include your search history with
printed records.

e Check Indent Text to indent the text of retrieved records under
the field labels.

*  Check One Record Per Page to start each printed record on a
new page.
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Check Print Graphics to print any graphics in the retrieved

records. Each graphic is printed with its title, caption, and
associated record number, if available.

5.

Click OK to close the dialog box. The next time you print retrieved
records, the new options will be in effect.

Note: To print a graphic by itself, you must first display the graphic in

the Graphic window. Refer to “Displaying Graphics” on page 5-13 for
more information.

Downloading Records

With WinSPIRS, you can download to a floppy or hard disk the records
retrieved by any of your searches. You can also determine which fields

are downloaded and whether graphics and the search history are
included.

To download records:
1. Click Download on the button bar, or select Download Records
from the File menu in the Search, Index, Table of Contents, or

Hotlink screen. WinSPIRS displays the Download Records dialog
box.

Download Records

File Name: Directories:
d\winspirs
READNE T 1 [&a -
= WINSPIRS
C1 CATALOG
S ENTiTY
£ ENTITYRC pons
1 LANGUAGE
2 £1 SHARED = _ﬂelp
Save Files as Type: Drives:
| Text Only(™.bet) =] [=ad:vamaw =]
Download Range Download Fields
O Marked Records @ As Shown
@ All Displayed Records ' Default
O Current Record [#1] C User-Selected
(O Marked and Default
C Records:
Enter record numbers and/or record ranges
separated by commas. For example: 1.4.6-10
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FIGURE 5-18 Download Records dialog box
2. Type a name for the download file in the File Name box.

3. Ifnecessary, choose a different drive and directory in which to save
the file.

4. Check the type of records you want to download in the Download
Range area:

* Marked Records downloads all records that are partially or
fully marked.

+ All Displayed Records downloads all records displayed from
the current search.

e  Current Record downloads the current retrieved record.

* Records lets you specify individual records to download.
Separate record numbers with commas, and use a hyphen to
indicate a range, suchas 1, 4, 6-10.

5. Check the fields you want to download:

*  As Shown downloads the currently displayed fields.

»  Default downloads the default fields for the database(s) you are
searching.

* User Selected downloads the fields selected in the Download
Records Options (click Options... to view or change the
selected fields).

*  Marked and Default downloads the default set of fields and any
additional text you have marked.

6. Click Download to begin downloading.

You can determine how records are downloaded by changing the
Download Records Options. These options include which fields are
downloaded, how field labels are downloaded, and whether the Search
History is downloaded.

To change download options:

1. Choose Download Options... from the Options menu or click
Options... in the Download Records dialog box. WinSPIRS displays
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the Download Records Options dialog box.

Download Records Options

Choose from these Fields/Fieldsets

HITS - Fields with search terms

Default (TLAU S0 SLAMN.OMN) —
CITN - CITATION (TLAU S0, SLAN QM)
TI-TITLE

Al - AUTHOR(S)

A4 - AUTHOR AFFILIATION

CA - CORPORATE AUTHOR(S)

AD - PRODUCER ADDRESS

50- S0URCE (BIBLIOGRAPHIC CITATION)
aq | _'l_I

Field Labels
@ Short Field Names
C' Long Field Names
) No Field Names

Download these Fields

>>Add>>

<<Remove<<

<<Remove All<<

il

Other Options
X Download Search History

X Download Record Numbers

TI-TITLE
Al- AUTHOR(S)

50 - SOURCE (BIBLIOGRAPHIC CITATION)
S1- SERIAL IDENTIFIER

AN - ACCESSION NUMBER

OM - UMI ORDER MUMEER:

| 0K I ‘ Cancel |

‘ Default Settings || Help |

FIGURE 5-19 Download Records Options dialog box

2. Add the fields you want to download to the Download these Fields

list.

Note: If the Make Default Fields button is available, you can make
the selected set of fields the download default for the current data-

base. You will be asked to restart WinSPIRS; the new default will

be effective every time you search the current database.

3. Indicate how you want fields to download in the Field Labels area:

* Short Field Names downloads field abbreviations, such as

“TI”.

* Long Field Names downloads full field names, such as “Title”.

* No Field Names omits field names from downloaded records.

4. Choose from the Other Options:

*  Check Download Search History to include your search

history with downloaded records.

e Check Download Record Numbers to include record numbers,
such as / of 7, with the downloaded records.
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*  Check Formatted ASCII Text to insert a carriage return/line
feed after approximately 72 characters on each line.

5. Click OK to close the dialog box. The next time you download
retrieved records, the new options will be in effect.

Note: To download graphics, you must first display the graphics in the
Graphic window. Refer to “Displaying Graphics” on page 5—13 for more

information.
Downloading SGML WinSPIRS 4.0 lets you download SGML records with the markup codes
Records intact. WinSPIRS also consolidates the available download file types

into a single list, so you can easily choose to download records as text,
text with line breaks, or SGML.

To download records:
1. Click Download on the button bar, or select Download Records

from the File menu in the Search, Index, Table of Contents, or
Hotlink screen. WinSPIRS displays the Download Records dialog

box.
Download Records
File Name: Directories:
Idnwnlnad,sgm d:\winspirs
1 2o :
£ WINSPIRS
0 CATALOG
& ety
1 ENTITYRC _puons. .
£ LANGUAGE
Sawve Files as Type: I}g Drives:
SGML{*.sgm) =| | = d: Yamato =l
Text Only(* txt) .
Text with Line Breaks(* b Download Fields

SGMLI™, ——
Csam) I — © As Shown
C All Displayed Records O Default
C Current Record [#3] O User-Selected

@ Marked and Default
O Records:

Enter record numbers and/or record ranges
separated by commas. For example: 1.4.6-10

FIGURE 5-20 Downloading records

2. Select a file type from the Save Files as Type: list.

*  Text Only downloads just the text of the records. Graphics are
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omitted.

+  Textwith Line Breaks downloads the text and inserts a carriage
return/line feed after approximately 72 characters on each line.

*  SGML downloads SGML records with their markup codes
intact. Note that WinSPIRS disables the Download Fields
options and the Options... button, which do not apply to SGML
records.

Type a name for the download file in the File Name box.

Note: If you are downloading multiple records as SGML, Win-
SPIRS truncates this file name to seven characters and appends to it
a unique number for each record. For example, if your file name is
download.sgm and you download two records, WinSPIRS creates
downloa1.sgm and downloa2.sgm. It does this to preserve each
record as a valid SGML document.

If necessary, choose a different drive and directory in which to save
the records.

In the Download Range area, check the type of records you want to
download.

Check the fields you want to download in the Download Fields area.
(This option is not available if you are downloading records in
SGML format.)

Click Download to begin downloading.

+ Ifyou are downloading as text and your records include SGML
and non-SGML records, WinSPIRS downloads all the non-
SGML records first, followed by the SGML records.

+ Ifyou are downloading as SGML, WinSPIRS skips all non-
SGML records and notifies you if the selected set of records
contains no SGML records. WinSPIRS downloads any external
SGML entities, such as graphics, as separate files. These are
named incrementally as ent1.ent, ent2.ent, and so on.
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WInSPIRS Commands

This chapter provides a brief definition for each button and menu item in
WinSPIRS. For more information, refer to the Index or to the online

Help.

Use this button/command

On this screen/menu

To do this

Add to List...

Add to Search

Alert Service

All Fields

Button on Thesaurus screen

Button on Search/Index/Table
of Contents screens

Search screen > File menu

Button on Search/Index/Table
of Contents screens

Add the current thesaurus term to a list of
terms to search

Add a highlighted term or phrase to the
Search: text entry area on the Search
screen

View entries in an Alert (current
awareness) service. The command is
available when SDI / Alert functionality
has been set up using the Reconfig utility.
(Authorized users only.)

Display all fields in the retrieved records.
It also expands the Retrieved Records
area if Auto Full Screen is on in the
Retrieved Records Options.

When you click All Fields, the button
changes to Brief Fields.

(Sheet 1 of 11)
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Use this button/command

On this screen/menu

To do this

Automatic Records
Display

Back

Back Up

Brief Fields

Change...

Change Index...

Change TOC

Clear...

Clear Search Area

Search/Index/Thesaurus/
Table of Contents screens
> Options menu

Hotlink window > Options
menu

Hotlink window and
Thesaurus screen
Back button

Button on Table of Contents
screen

Search/Index/Table of
Contents screens

Index screen

Index screen > Options menu

Table of Contents screen >
Options menu

Button on Table of Contents
screen

Search screen > Search
History area

Search/ Index/Thesaurus
screens > Edit menu

Determine whether retrieved records are
displayed after each search.Turn
Automatic Records Display off for faster
searching; retrieved records are only
displayed when you click Show in the
Retrieved Records area.

At the Hotlink window, Back display the
previous hotlinked record that you viewed.

At the Thesaurus screen, Back display
the previous term information or permuted
index that you viewed.

Move up one level higher in the Table of
Contents (SGML databases only)

Display the current set of fields selected in
the Retrieved Records Options dialog
box. It also shrinks the Retrieved Records
area if Auto Full Screen is on in the
Retrieved Records Options.

When you click Brief Fields, the button
changes to All Fields.

Display a list of available indexes from
which you can choose a different index to
search.

Display a list of available indexes from
which you can choose a different index to
search

Change to the Table of Contents of
another loaded database.

Erase one or more searches from the
current search history

Erase all text from the text entry area of
the active screen.
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Use this button/command

On this screen/menu

To do this

Clear Search History...

Clear Term List

Clear Thesaurus History

Close

Colours...

Contents

Contract

Contract All

Copy

Create SDI

Search screen > Edit menu
Thesaurus screen > Edit
menu

Thesaurus screen > Edit
menu

Graphic/Hotlink/Full Text
windows

Search/ Index/Thesaurus/
Table of Contents screens >
Options menu

Button bar

Table of Contents screen

Table of Contents screen

Edit menu

Search screen > File menu

Erase all or a portion of your current
search history.

Delete all terms you added to the Selected
Term List for later searching.

Clear the Thesaurus History, which lists
all the terms you viewed while in the
Thesaurus

To view the Thesaurus History, select
Show Thesaurus History from the
Options menu.

Close the active window

If you leave the window open, you can
display it again by selecting Graphic
Window or Hotlink Window from the
Views menu.

Change the color scheme of the
WinSPIRS display

Display the Table of Contents screen for
full-text databases. The button is grayed
out if you are not searching a full-text
database.

Contract the highlighted Table of
Contents topic (Non-SGML full text
databases)

Contract all expanded Table of Contents
topics (Non-SGML full text databases)

Copy the highlighted text or graphic to the
Clipboard for later pasting.

Launch a browser connection to
WebSPIRS to create an SDI. The
command is available when SDI / Alert
functionality has been set up using the
Reconfig utility. (Authorized users only.)
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6—4 WinSPIRS Commands

Use this button/command

On this screen/menu

To do this

Database

Delete Saved Searches...

Download

Download Graphic...

Download Options...

Download Records...

End of Record

Exit
Expand

Explode

Fast Phrase Searching

Button bar

Search screen > File menu

Button bar

Button on Download Records
dialog box

Graphic window > File menu

Search/ Index/Table of
Contents/Hotlink screens >
Options menu

Search/Index/Table of
Contents/Hotlink screens >
File menu

Search/ Index/ Table of
Contents/Hotlink screens >
Records menu

File menu.

Table of Contents screen

Button on Thesaurus screen

Search screen > Options
menu

Displays a list of available databases from
which you can select one or more to
search

Erase previously saved search histories
from a floppy or hard disk

Download retrieved records to a floppy or
hard disk

Save the currently displayed graphic to a
floppy or hard disk.

Note: Even if graphics are displayed in
the body of the record, they must be
downloaded separately.

Determine which fields are downloaded
and whether the Search History is
included.

Save the results of your current search to
a floppy or hard disk.

Move to the end of the current record.

Exit WinSPIRS

Expand the highlighted Table of Contents
topic.

Search for anitem, and any of its narrower
terms.

When it is selected, WinSPIRS searches
for the individual terms of a phrase in the
same field, rather than necessarily
adjacent. This results in faster searching,
but less precision.

Fast Phrase Searching is not available for
all SilverPlatter databases.

(Sheet 4 of 11)



Use this button/command On this screen/menu

To do this

Fields to Search...

Fit to Window

Full Text Search

Full Text Window

Go to Top

Graphic Window

Guide

Help

Hotlink Window

Index

Index Full Screen

Search screen > Utilities menu

Graphic window > View menu

Search/Index/Contents >
Utilities menu

Button on Full Text Window

Search screen > Views menu

Table of Contents screen

Views menu

Help menu

Search/ Index/
Thesaurus/Table of Contents
screens > Views menu

Search/ Thesaurus/Table of
Contents screens >Views
menu

Index button appears on the
Button bar

Index screen >Views

Display a list of searchable fields in the
database(s) you are searching

Resize the displayed graphic to fit in the
window. It is useful if you have changed
the magnification of a graphic or if you
have resized the window

Search the full elements in any loaded
SGML databases.

Bring the open Full Text window to the
foreground. (Only available if the Full Text
window is open.)

Reset Table of Contents to highest level of
topics. (SGML databases.)

Bring the open Graphic window to the
foreground. (Only available if the Graphic
window is open.)

Provide unique and specific information
about the database(s) you are using

Provide information about using the
WInSPIRS software. Press [F1] or click
the Help button to get Help on the active
window or dialog box. You can also
choose a Help topic from the Help menu.

Bring the open Hotlink window to the
foreground. (Only available if the Full Text
window is open.)

Open the Index screen.

Expand the Index area
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6-6 WinSPIRS Commands

Use this button/command

On this screen/menu

To do this

Language Options...

Limit...

Load and Run Searches...

Look Up

Make Default Fields

Mark Paragraph

Mark Record

Mark Reference Fields

Mark Section

Next Hit

Search/ Index/
Thesaurus/Table of Contents
screens > Options Menu

Search screen > Search
History area

Search screen > File menu

Index/Thesaurus screens

Download Records Options/
Print Records
Options/Retrieved Records
Options dialog boxes.

Button

Search/ Index/Table of
Contents/ Hotlink screens >
Mark menu

Search/ Index/Table of
Contents/Hotlink screens >
Mark menu

Search/ Index/Table of
Contents/Hotlink screens >
Mark menu

Search/ Index/Table of
Contents/Hotlink screens >
Mark menu

Search/Index/Table of
Contents/Hotlink screens >
Records menu

Next Hit button is available at
the bottom of those screens.

Select the language in which WinSPIRS
displays screens, buttons, and menu
items.

Limit the current search by language,
publication year, or other limit field

Reuse a previously saved search history.

Look in the Index Terms or Permuted
Index for the term you typed, and scrolls to
the nearest match.

Make the selected fields the default for
downloading, printing, or showing records
with the current database. WinSPIRS
needs to restart to change the default
fields.

The Make Default Fields button is
unavailable if WinSPIRS is not configured
to allow setting of default fields.

Mark the current paragraph of a full-text
record. (Non-SGML databases.)

Mark the current record for later printing or
downloading

Mark the bibliographic fields of a full-text
record. (Non-SGML databases.)

Mark the current section of a full-text
record. (Non-SGML databases.)

Move to the next occurrence of the term
you searched.
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Use this button/command

On this screen/menu

To do this

Next Record

Paste

Previous Hit

Previous Record

Print

Print Graphic...
Print Options...

Print Records...

Print Setup...

Records Full Screen

Search/ Index,/Table of
Contents screens > Records
menu

Search/ Index/Thesaurus/
Table of Contents screens >
Edit menu

Search/Index/Table of
Contents/Hotlink screens >
Records menu

Previous Hit button is
available at the bottom of
those screens.

Search/ Index/Table of
Contents screens > Records
menu

Button bar
Graphic window > File menu

Search/Index/Hotlink screens
> Options menu

Button on Print Records dialog
box

Search/Index/Table of
Contents/Hotlink screens >
File menu

Search/Index/Table of
Contents/Hotlink/Graphic
screens > File menu

Button on Print Records dialog
box

Search/ Index/ Table of
Contents screens > Views
menu

Move to the record immediately following
the current record

Insert the contents of the Clipboard at the
insertion point. Paste is only available if
you have copied text from WinSPIRS or
another application to the Clipboard.

Move to the previous occurrence of the
term you searched.

Move to the record immediately preceding
the current record

Print retrieved records.

Print the displayed graphic.

Determine which fields are printed, how
field names are printed, and whether

graphics and the search history are
included.

Print retrieved records
Select which printer to use, page
orientation, and paper size. See your

Windows documentation for details on
Print Setup options

Expand the Retrieved Records area.
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WinSPIRS Commands

Use this button/command

On this screen/menu

To do this

Reset Thesaurus

Restart...

Retype

Save Search History...

Search

Search History Full
Screen
Search List

Search Now

Search Options

Thesaurus screen > Options
menu

Search/ Index/Table of
Contents/Thesaurus screens
> File menu

Search screen > Search
History area

Search screen > File menu

Button on Search/Index
screens

Search screen > Views menu
Button on the Thesaurus
screen.

Button on the Thesaurus
screen.

Radio buttons on Thesaurus
screen

Choose Reset Thesaurus to clear the
term list and Thesaurus history and return
the Thesaurus to its startup condition

Reset all options to their defaults, clear
the Search History, and restart WinSPIRS

Re-enter the text of the highlighted search
in the Search: text entry area,

Edit the statement and search again
without retyping the entire statement.

Save your search history to a floppy or
hard disk for later use.

On the Search screen, it searches for the
term you typed in the Search: text entry
area. On the Index screen, it copies the
highlighted index term to the Search
screen and searches for the term.

Expand the Search History area

Search for the Thesaurus terms you have
added to the Term List

Copy the highlighted thesaurus term to
the Search screen and searches for the
term. (Depending on the database, you
may be prompted to add one or more
subheadings to the term before
searching.)

Select one of the following, then click
Search Now

Single Term: to search only for that term.

Explode: to search for that term, and any
narrower terms.
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Use this button/command

On this screen/menu

To do this

Searches

Select Database...

Show

Show Full Text

Show Held Titles Only

Show Hits Per Database

Show Intermediate
Results

Show Marked Records

Show Options...

Show SDI

Search/
Index/Thesaurus/Table of
Contents screens > Views
menu

Searches button appears on
the button bar.

Search screen > File menu

Search/Index/Table of
Contents screens

Button on Search screen

Search/Index/Table of
Contents screens > Records
menu

Search screen > Options
menu

Search screen > Options
menu

Search/Index screens >
Records menu

Search/Index/Table of
Contents/Hotlink screens >
Options menu

Search screen > File menu

Move to the Search screen

Display a list of available databases from
which you can select one or more to
search.

Display the record(s) associated with the
highlighted search statement, index term,
or contents heading.

Show the full text of a record. (Full text
databases only.)

Display only records from documents held
at your library. It is only available if your
system administrator has set up a library
holdings file.

Indicate the number of records your
searches retrieve from each database, if
you are searching more than one

Display the results of each word when you
search for a phrase, rather than just the
results of the phrase.

Show only the retrieved records you have
marked.

Determine which fields are displayed, how
field names are displayed, and whether
graphics are displayed.

Launch a browser connection to
WebSPIRS to view and edit existing SDls.
The command is available when SDI /
Alert functionality has been set up using
the Reconfig utility. (Authorized users
only.)
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WinSPIRS Commands

Use this button/command

On this screen/menu

To do this

Show Thesaurus History

Sort Records...

Split Screen

Start of Record

Suggest

Synchronize

Table of Contents

Table of Contents Full
Screen

Term Information

Thesaurus

Undo Last Move

Thesaurus screen > Options
menu

Search/Index screens >
Records menu

Search/Index,/ Table of
Contents screens > Views
menu

Search/ Index/Table of
Contents, and Hotlink screens
> Records menu

Button on Search screen.

Table of Contents screen

Search screen/ Index screen
/Thesaurus screen >Views
menu

Table of Contents screen
>Views menu

Thesaurus screen.

Search/Index/Table of
Contents screens > Views
menu

Thesaurus button appears on
the button bar.

Search/Index/Table of
Contents/Hotlink screens >
Records menu

Display a list of the thesaurus terms you
have viewed.

Sort retrieved records and specify the field
to sort on and the order in which to sort

Divide the screen between the Retrieved
Records area and the Search History,
Index Terms, or Table of Contents area

Move you to the beginning of the current
record

Provide alternate search terms for the
term you enter

Display the portion of the Table of
Contents that corresponds to the text
currently displayed in the Retrieved
Records area

Display the Table of Contents screen for
full-text databases Note: The Table of
Contents command is disabled in
bibliographic databases

Expand the Table of Contents area
Display details about a highlighted term,
such as definitions, scope notes, and
broader and narrower terms.

Display the database’s online Thesaurus

Cancel the last action you performed
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Use this button/command On this screen/menu

To do this

Unmark All

Unmark Paragraph

Unmark Record

Unmark Reference Fields

Unmark Section

View Full Tree

View Last Suggestions...

View List...

View Loaded Databases...

Zoom In

Zoom Out

Search/Index/Table of
Contents/Hotlink screens >
Mark menu

Search/ Index/Table of
Contents/Hotlink screens >
Mark menu

Search/Index/Table of
Contents/Hotlink screens >
Mark menu

Search/Index/Table of
Contents/Hotlink screens >
Mark menu

Search/Index/Table of
Contents/Hotlink screen >
Mark menu

Thesaurus screen > Options
menu

Search screen >Utilities menu

Button on the Thesaurus
screen

Search/Index/Thesaurus/
Table of Contents screens
>Utilities menu.

Graphic window >View menu

Zoom In button is available at
the top of the Graphic window.

Graphic window >View menu

Zoom Out button is available
at the top of the Graphic
window

Unmark all marked records

Unmark the current paragraph of the full-
text record

Unmark the current record

Unmark the bibliographic fields of the
current full-text record

Unmark the current section of the full-text
record.

Display all the broader and narrower
terms of the current term. This is not
available for all thesauri.

Display the list of alternate search terms
from the last time you clicked Suggest.

Display the list of Thesaurus terms you
have selected for searching

List the currently loaded databases.

Enlarge the current graphic

Shrink the current graphic
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A

Add to List 6-1

Alert Service 6-1

Alerts
configuring 2-10
subscribing to 4-33

All Fields 6-1

AND operator 4-6, 4-34

authors. see hyphenated phrases;
searching in specific fields

Auto Full Screen 5-2

Automatic Records Display 4-3, 5-1, 6-2

Automatic Subject Lookup. See Suggest

automatic subject lookup. see suggested
terms

B
Boolean operators. see operators
broadening your search 4-34
broader terms. see Thesaurus
button bar
Database button 6-4
Download button 6-4
Index button 6-5
overview 3-4
Print button 6-7
Searches button 6-9
Thesaurus button 6-10

C
changing
fonts 5-3
indexes 4-16, 6-2
languages 6-6
see also options
clearing
saved search histories 6-4
searches from search history 4-29, 6-

3

Index

combining search terms 4-4, 4-6—4-8
configuring WinSPIRS 2-6
contents. see Table of Contents
contracting topics 4-25
see also Table of Contents
conventions. see Manual conventions
copying text, graphics 6-3
Create SDI 6-3
current awareness searches
configuring 2-9
using SDIs and Alerts 4-31

D
databases
full-text. see Table of Contents
Guide to 3-11, 6-5
searching multiple 3-2, 4-33, 4-34
Show Hits Per Database 6-9
selecting 3-2-3-3
title screen, illustrated 3-3
View Loaded Databases 6-11
see also searching
default fields
for downloading 5-24, 6-6
for printing 5-21, 6-6
for showing 5-2, 6-6
deleting
Delete Saved Searches 6-4
see also clearing
descriptors. see hyphenated phrases;
Thesaurus
displaying. see showing
downloading
graphics 5-16
Make Default Fields 5-24, 6-6
marked records 5-23
options 2-7, 5-23, 6-4
records 5-22-5-25, 6-4



search history 5-24

SGML records 5-25
downloading SilverPlatter software

ERL 2-2

E
End of Record 6-4
ERL options 2-7
examples of searching 4-2—4-3
exiting WinSPIRS 3-12, 6-4
expanding topics 4-25, 6-4
see also Table of Contents
exploding terms
in the Thesaurus 4-21
suggested terms 4-14

F

Fast Phrase Searching 6-5

fields
field names 5-2, 5-21, 5-24
Fields to Search 4-9
field-specific indexes. see Index
limit fields 4-10—4-11
searching in 4-4, 4-9—4-11
showing all 6-1
sorting 5-3

finding records. see searching

Fit to Window 5-15, 6-5

Fixed Font 5-3

fonts 5-3

Free Text Index 4-16

full text records 5-4
displaying from non-SGML databases

5-7

displaying from SGML databases 5-6
showing 5-4

full text. see Table of Contents

Full Tree View 4-19

G
graphics
copying 6-3

downloading 5-16

Fit to Window 5-15, 6-5

printing 5-16, 5-22, 6-7

showing 5-2, 5-13-5-16

zooming in and out 5-15, 6-11
Guide

showing 3-11, 6-5

stopwords list 4-14

H
hardware and software requirements 2-2
hardware requirements 2-2
Help
database-specific Guide 3-11, 6-5
WInSPIRS Help 3-11-3-12, 6-5
history. see search history; Thesaurus
history
hits in retrieved records
Next Hit 6-6
Previous Hit 6-7
Show Hits Per Database 6-9
Holdings Conversion Utility 2-12
hotlinked records 5-8, 6-5
hyphenated phrases 4-4

|
IN operator 4-4, 4-10
indenting text
in displayed records 5-2
in printed records 5-21
Index
changing 4-16, 6-2
Free Text Index 4-16
overview 3-7
searching 4-14-4-17, 4-34
selecting terms 4-16
showing records 4-15
stopwords 4-14
installing ERL
downloading the software 2-2
installing WinSPIRS 2-2
networks 2-4



requirements 2-2

L
languages, changing 6-6
lateral searching 5-7
library holdings 2-12
configuration options 2-7, 2-15
configuring default messages 2-14
disabling holdings 2-13
displaying details 5-12
Show Held Titles Only 5-13, 6-9
limit fields 4-10—4-11
Load and Run Searches 4-31, 6-6
looking up terms
in the Index 4-14
in the Thesaurus 4-17

M
Make Default Fields 5-2, 5-21, 5-24, 6-6
making information available 2-12
Manual conventions v
marking records 5-17, 6-6
downloading marked records 5-23
printing marked records 5-19
SGML records 5-18
showing marked records 6-9
menus, overview 3-4-3-6

N

narrower terms. see Thesaurus

narrowing your search 4-34

natural language mapping. see suggested
terms

NEAR operator 4-6, 4-34

networks
accessing network databases 2-8
installing WinSPIRS 2-4

Next Hit 6-6

NOT operator 4-8, 4-34

(0]
operators
AND 4-6, 4-34

definitions of 4-6—4-8
IN 4-4, 4-10
NEAR 4-6, 4-34
NOT 4-8, 4-34
OR 4-7, 5-8
WITH 4-6, 4-34
options
configuring WinSPIRS 2-6
downloading 5-23, 6-4
printing 5-20, 6-7
showing 5-1, 6-9
OR operator 4-7, 5-8

P
parentheses 4-4, 4-5
pasting text 6-7
Permuted Index 4-17
preferences. see options
Previous Hit 6-7
Previous Record 6-7
printing
graphics 5-16, 5-22, 6-7
Make Default Fields 5-21, 6-6
marked records 5-19
options 2-7, 5-20, 6-7
Print Setup 6-7
records 5-19-5-22, 6-7
search history 5-21
SGML records 5-20
proximity operators. see operators

Q
quitting WinSPIRS 3-12, 6-4
quotes 4-4

R
reconfiguring WinSPIRS 2-6
record outline 5-6
non-SGML databases 5-7
SGML databases 5-6
records
downloading 5-22-5-25, 6-4



full text 5-4
hotlinked records 5-8, 6-5
marking 5-17, 6-6
navigating
End of Record 6-4
Next Hit 6-6
Previous Hit 6-7
Previous Record 6-7
Start of Record 6-10
Undo Last Move 6-10
printing 5-19-5-22, 6-7
selecting terms from 5-7
showing 5-1, 6-9
All Fields 6-1
Automatic Records Display 4-3,
5-1, 6-2
sorting 5-3, 6-10
unmarking 5-17, 6-11
see also downloading; printing;
searching; showing
related terms. see Thesaurus
requirements 2-2
Reset Thesaurus 6-8
restarting WinSPIRS 3-12, 6-8
Retype button 6-8
reusing search requests 4-4, 4-29
running saved searches 4-31

S
saving
search histories 4-30, 6-8
see also downloading
SDI/Alert menu items 2-11
SDIs
configuring 2-10
creating 6-3
showing 6-9
search history
clearing searches from 4-29, 6-3
downloading 5-24
printing 5-21

reusing searches 4-29
saving 4-30, 6-8
Delete Saved Searches 6-4
Load and Run Searches 4-31, 6-
6
Search History Full Screen 6-8
Show Hits Per Database 6-9
Show Intermediate Results 6-9
searching
combining terms 4-6—4-8
examples 4-2-4-3
Fast Phrase Searching 6-5
fields 4-4, 4-9—4-11
finding word variants 4-3, 4-4
from retrieved records 5-7
hyphenated phrases 4-4
limit fields 4-10—4-11
multiple databases 4-33, 4-34
narrowing and broadening your
search 4-34
numbers 4-4
operators 4-4, 4-6—4-8
options 2-7
parentheses 4-4, 4-5
quotes 4-4
reusing previous searches 4-4
Search screen, overview 3-6, 4-2
semi-colons 4-4
stopwords 4-14
suggested terms 4-13, 6-10, 6-11
truncation and wildcards 4-3, 4-4, 4-
34
see also Index; search history; Table
of Contents; Thesaurus
selecting
databases 3-2—3-3
Index terms 4-16
indexes 4-16
terms from records 5-7
Thesaurus terms 4-20, 6-1
see also changing; marking



semi-colons 4-4
SGML full text
searching 4-11
SGML records
Back Up button 6-2
displaying 5-6
downloading 5-25
marking 5-18
printing 5-20
Show SDIs 6-9
showing
All Fields 6-1
Automatic Records Display 4-3, 5-1,
6-2
fonts 5-3
full text records 5-4
graphics 5-2, 5-13-5-16
Make Default Fields 5-2, 6-6
marked records 6-9
options 5-1, 6-9
records 6-9
from non-SGML databases 5-7
from SGML databases 5-6
in Hotlink window 5-8
in Index 4-15
in Search screen 4-3, 5-1
in sorted order 5-3
in Table of Contents 4-26
Show Held Titles Only 6-9
Show Hits Per Database 6-9
Show Intermediate Results 4-3, 6-9
Split Screen 6-10
Thesaurus history 6-10
trees in Thesaurus 4-19
see also viewing
SilverLinker
configuring 2-8
displaying links 5-11
SilverPlatter
Software Resource CD 2-3
SilverPlatter Information 1-3

software requirements 2-2
sorting records 5-3, 6-10
SPLHA. see library holdings
Split Screen 6-10
Start of Record 6-10
starting WinSPIRS 3-1
stopwords 4-14
subheadings 4-22
suggested terms 6-10
exploding 4-14
searching for 4-13
View Last Suggestions 6-11
Synchronize button 4-27, 6-10
synonyms. see Thesaurus

T
Table of Contents
changing 6-2
expanding topics 6-4
overview 3-10
searching 4-25-4-27
showing records 4-26
Synchronize button 4-27, 6-10
Table of Contents Full Screen 6-10
tables. see Fixed Font
Term Information 4-18, 6-10
Thesaurus
overview 3-9
Permuted Index 4-17
resetting 6-8
searching 4-17-4-24, 4-34, 6-8
selecting terms 4-20, 6-1
subheadings 4-22
Term Information 4-18, 6-10
Thesaurus history
showing 4-23, 6-10
trees 4-19
View Full Tree 4-19, 6-11
View List 4-21, 6-11
title screen 3-3
trees 4-19



truncation 4-3, 4-4, 4-34

U
Undo Last Move 6-10
unmarking records 5-17, 6-11

\'}
valid search requests 4-3
verLinker 5-11
viewing
tables. see Fixed Font
View Full Tree 4-19, 6-11
View Last Suggestions 6-11
View List 6-11
View Loaded Databases 6-11
see also showing

w
wildcards 4-4, 4-34
WIinSPIRS
button bar 3-4
configuring 2-6
exiting 3-12, 6-4
Help 3-11-3-12, 6-5
installing 2-2
languages 6-6
menu bar 3-4-3-6
restarting 3-12, 6-8
starting 3-1
winspirs.ini 2-8
WITH operator 4-6, 4-34
workstation options 2-7

Z
zooming in and out of graphics 5-15, 6-11
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